TCFI Gen 4 Fuel Injection System

O .
\X)/ TW' ﬂ TeC Installation & Tuning Manual

CAUTION: CAREFULLY READ INSTRUCTIONS BEFORE PROCEEDING. NOT LEGAL FOR
SALE OR USE IN CALIFORNIA OR ON ANY POLLUTION CONTROLLED VEHICLES.

OVERVIEW process, please contact our tech support at 386-
. L 304-0700.
The Twin Tec TCFI Gen 4 fuel injection
controller replaces the original equipment (OE) 36 pin 4. USB interface. Read the USB interface instructions
Delphi® controller on 2001 and later Harley-Davidson® starting on page 17, install the USB drivers and
motorcycles with fuel injected engines. Note that the configure the COM port.
TCFI Gen 4 is not compatible with 2011 and later 5. PC Link software used for setup and engine

models with CAN data bus. The term TCFl is used
throughout this document as a generic term and
refers to the new TCFI Gen 4 controller unless

otherwise noted. 6. Data logging software. Read the TCFI Log

instructions starting on page 34 and install the
The TCFI Gen 4 kit includes the new WEGO IIID eoftware gonpag
dual channel wide-band exhaust gas oxygen sensor '

interface that allows simultaneous front and rear .
cylinder auto-tuning during actual riding conditions. WARNING: You must use version 15.0 or

higher PC Link TCFI software for setup
and tuning. Note that TCFI Il (Gen 3)

tuning. Read the PC Link TCFI instructions starting
on page 19 and install the software.

CAUTION: Tuning the TCFl requires setup files may be used with the TCFI
competency in PC operation, using Gen 4. To access all logged data, you
Microsoft Windows based programs, must use version 15.0 or higher TCFI
and basic engine tuning and fuel Log software.

injection mapping concepts. The TCFI
installer is assumed to be familiar with _ _
b B O] inleeiion SYsiarm el @6 7. TCFI Controller. Read the TCFI installation
p | . y . instructions starting on page 41 and install the
have access to basic test equipment TCFI unit.

and factory service manuals. 8. WEGO wide-band exhaust gas oxygen sensor

interface. Read the WEGO installation instructions

QUlCK START SYSTEM starting on page 42, m;tall 'ghe WEGQ unit and
perform the free air calibration described on page
INSTALLATION AND SETUP 43
1. Check the exhaust system. If you can insert a 9. Connect the USB interface cable between the
broomstick through the mufflers, you have the TCFI unit and your PC.
equivalent of open drag pipes and auto-tuning will . .
fail. If app|icab|e, read the section about exhaust 10. Start the PC Link TCFI software, _USE the Open File
considerations starting on page 11. command, and open the appropriate setup file.
i ) ) Setup data files are provided in the program folder
2. Check for updates. This tuning manual is for TCFI for typical engine applications. Refer to Table 3 on
Gen 4 units. Before proceeding, check our website page 16 for details. Additional setup guidelines for
at www.daytona-twintec.com for available updates aftermarket throttle bodies and larger displacement
for the TCFI firmware, accompanying PC based engines are given on page 9.

software, and documentation. . .
11. Use the Edit Basic Parameters command. Make

3. Tech support. If you have_questio_ns or encounter any required changes such as estimated rear
problems at any point during the installation wheel horsepower, injector flow rating (refer to
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12.

13.

14.

15.

16.

17.

Table 1 on page 9), and RPM limit. You must set
the vehicle speed sensor (VSS) frequency for
your model. This affects speedometer/odometer
scaling, idle RPM control, and turn signal
cancellation. Refer to pages 28-29. Do not change
any other parameters or options unless there is a
specific reason to do so. Click OK when done.

Use the Save File command to save your initial
setup file with an easily identifiable name (refer to
suggestions in the editing and file operations
section on page 3).

Turn the ignition key and run/stop switch on.
Upload the setup data to the TCFI unit. Turn the
run/stop switch off. This initializes the idle air
control (IAC) motor.

Start the TCFI Log software. Turn the run/stop
switch on but do not start the engine. Use the View
Idle TPS command on the View menu. Idle throttle
position sensor (TPS) volts are displayed on the
TPS bar graph gauge. The TPS value must be
within the range of .30-.80 volts. If not, refer to the
throttle body setup and idle TPS adjustment
sections starting on page 5. Turn the run/stop
switch off when complete.

Cold start test and initial auto-tuning. Position the
motorcycle so that you can perform a cold start test
while monitoring engine data with TCFI Log
software and then be able to disconnect the USB
interface and ride the bike for initial auto-tuning. To
allow viewing and logging air/fuel (AFR) data
immediately after engine start, turn the ignition
switch on but leave the run/stop switch in the stop
position. Wait at least 15 seconds for the WEGO
sensors to warm up and then start the engine.
Monitor real time engine data and status with TCFI
Log software.

Allow the engine to idle until it reaches 110° C
(230° F) engine temperature (ET). This will
typically take about 10 minutes. A fan should be
used to direct cooling air on the engine to more
realistically simulate actual warm up conditions. If
the engine does not start or stalls, refer to the
diagnostic tips in the idle tuning section starting on
page 6.

Monitor front and rear cylinder AFR and block learn
multiplier (BLM), ET, and IAC values. Keep notes
on your observations of these values. After 30
seconds, the system should be operating in closed
loop and maintaining the desired idle AFR (nominal
value of 13.5). The BLM values should remain
within the range of 80-120%. The IAC value should
slowly go down as the engine reaches operating

18.

19.

20.

temperature and requires less idle air. BLM values
below 100% indicate that the TCFI is removing fuel
in closed loop to correct a rich condition. BLM
values above 100% indicate that the TCFI is
adding fuel in closed loop to correct a lean
condition. Refer to the TCFI operation section
starting on page 3 for details. If the BLM values go
below 80% or above 120% anytime during the
warm up period, the system is running out of
adjustment range. Refer to the suggestions in the
idle tuning section starting on page 6.

Once the engine reaches 110° C (230° F) ET, do
not shut the engine off, disconnect the USB cable,
and ride the motorcycle for at least 15 minutes.
Repeatedly accelerate through the useable RPM
range in every gear at different throttle positions.
Also operate the motorcycle at various fixed
speeds likely to be encountered during normal
riding. For safety reasons, wide open throttle runs
should be done on a closed course. If lean surging
or spark knock is noted, refer to the suggestions in
the auto-tuning section starting on page 8.

Hot restart test. After the initial ride, shut the
engine off and allow it to hot soak for 10 minutes.
To allow viewing and logging AFR data
immediately after engine restart, turn the ignition
switch on but leave the run/stop switch in the stop
position. Wait at least 15 seconds for the WEGO
sensors to warm up and then restart the engine
and let it idle. Monitor real time engine data and
status with TCFI Log software. Verify that the AFR
values do not exceed 15.0 before closed loop
operation. Allow the engine to idle until it reaches
110° C (230° F) ET again. Verify that the IAC
position is in the range of 25-40 steps. If not, refer
to the suggestions in the idle tuning section
starting on page 6.

Auto-tuning. The closed loop auto-tuning process
consists of operating the motorcycle through a
wide range of loads and speeds while periodically
monitoring progress using the PC Link TCFI
software. Long rides at constant speed and load
are of no value. After 1-2 hours of engine
operation, download the current setup with PC Link
TCFI software and use the Edit 3D Table — BLM
Tables — Edit Front and Edit Rear BLM Table
commands to examine the BLM tables. Cells that
are shaded red indicate that the system has run
out of correction range. Then use the Apply Front
and Apply Rear BLM Table commands to
automatically correct the Alpha-N fuel table and
front cylinder trim table. This also resets all the
BLM values back to 100% and allows auto-tuning
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to continue. Save the edited setup file to disk and
upload it to the TCFI. Continue this auto-tuning
process until most of the BLM cells remain in the
90-110% range. Refer to the auto-tuning section
starting on page 8 for more details.

21. Final checks. Verify absence of spark knock during
throttle roll on and wide open throttle acceleration.
Verify that the speedometer reading is accurate
and that the turn signals cancel properly. 2007 and
later models only: verify proper operation of 6th
gear indicator light. If required, operate the
motorcycle at a steady speed around 50 MPH in
6th gear and then download data with TCFI Log.
Use the gear ratio display function to determine the
actual 6th gear ratio. Use PC Link TCFI software to
download the current setup data, enter the new 6t
gear ratio into Module Parameters, save the edited
setup file to disk, and upload it to the TCFI.

EDITING AND FILE OPERATIONS

After initial setup, the TCFI tuning process
requires multiple edits of the engine tables and
parameters using PC Link TCFI software. Unless
otherwise noted, editing involves downloading the
current setup data in the TCFI, performing the required
edits, saving table edits to buffer memory, saving the
revised setup file to disk, and then uploading it to the
TCFI. You should always print out any affected tables
and parameters and save each revised file with a
unique filename. Use a filename that incorporates the
customer name and a date code, such as
Chris_20090410a.dat. We suggest that you create a
separate folder for all tuning files. Keep detailed written
notes on the changes you make and the associated
filenames. Make frequent backup copies onto
removable media such as a USB Flash drive.

New customers with limited PC experience often
become confused and have problems with simple
Windows file management functions including the use
of the Windows Explorer. We regret that we cannot
provide tech support for Windows related issues. We
suggest that you spend some time practicing with the
PC Link TCFI and TCFI Log software, including the
Copy, Paste, and Modify commands on the right
mouse button popup menu.

OVERVIEW OF TCFI OPERATION

The TCFI controls air/fuel ratio (AFR) and idle
RPM using individual control loops. Each control loop
can operate open loop (without feedback correction) or
closed loop (with feedback correction) depending on
conditions.

If you are not familiar with control systems
concepts such as open and closed loop operation, we
suggest that you order Understanding Automotive
Electronics (Sixth Edition) by William B. Ribbens from
www.amazon.com. Chapter 2 includes an excellent
introduction to control system theory.

The output of the AFR control loop is injector
pulse width. A higher pulse width causes more fuel to
be injected and decreases the AFR towards a rich
condition. An initial estimate of horsepower and injector
size (flow rate) is used to calculate a base injector
pulse width. Base injector pulse width corresponds to
the amount of fuel required to generate a
stoichiometric mixture (14.7 AFR) at wide open throttle
(WQOT), 6,000 RPM and standard atmospheric
conditions. Base injector pulse width is then corrected
for intake air temperature (IAT) and barometric
pressure.
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At any given RPM and throttle position (TPS),
the corrected base injector pulse width is multiplied by
the values in the Alpha-N table (main fuel table), AFR
table (the AFR command), front cylinder trim table
(only for the front cylinder), and block learn multiplier
(BLM) tables. The BLM tables store closed loop
correction factors based on feedback from the WEGO
system. Independent BLM tables are used for front and
rear cylinders. The BLM tables are continually updated
whenever the system is operating in closed loop
(generally 30 seconds after engine start). The BLM
tables are updated based on the AFR error (difference
between AFR command and actual AFR read by the
WEGO system). During auto-tuning, BLM values are
only saved if the engine reaches 95° C (200° F) and
runs for at least 5 minutes. This is set by warm engine
temperature and engine warm-up time parameters
(refer to page 29). In cold climate areas, you may have
to use a lower value for warm engine temperature.

Additional cold start enrichment fuel is applied
based on engine temperature and elapsed time since
engine start. Priming fuel is injected when the run/stop
switch is cycled on. A fixed pulse width injection is also
used during cranking (RPM < 400). Two tables set the
priming and cranking pulse widths based on engine

temperatu
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The output of the idle RPM control loop is idle air
control (IAC) stepper motor position ranging from 0-
127. A higher IAC value allows more air flow and
increases engine RPM. A table sets the idle RPM
command as a function of engine temperature. This
allows a higher idle RPM while the engine is cold.
Closed loop idle RPM control is only enabled when
vehicle speed is zero and TPS is less than the idle
TPS value (usually 1%). Under open loop conditions
(such as the motorcycle being driven while the engine
is warming up), IAC position is continually adjusted
based on engine temperature and elapsed time since
engine start. When the engine is fully warmed up, the
system assumes that the IAC position will be close to a
nominal value (usually 30). Additional idle air (IAC >
nominal IAC value) is considered the same as
increasing TPS since the effect on airflow is identical.
Under cold start conditions, when the IAC value is
high, the system may be using the 2.5% or 5% TPS
rows in the fuel tables even when the throttle is closed.

The nominal idle IAC value (IAC steps once
engine is fully warmed up and at stable idle condition)
is automatically sampled and updated. This occurs
after 8 seconds of stable idle whenever vehicle speed
returns to zero while the motorcycle is operated. The
updated value is saved after engine shut down. This
feature eliminates the requirement to set the nominal
idle IAC value as part of the tuning process and allows
the system to automatically accommodate different
throttle bodies.

For more detailed explanations of the AFR and
idle RPM control loops and various tables, please
download the TCFI Idle Tuning Tech Note.
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THROTTLE BODY SETUP

An alpha-N (throttle position and RPM based)
fuel control system such as the TCFI requires that
certain condition be met by the throttle body. All
aftermarket throttle bodies and even some stock
Delphi® units will require adjustment for proper
operation.

Idle control is by means of the IAC system. The
throttle blade(s) must remain at a fixed position against
the idle stop screw when the throttle is closed. The
throttle body is affected by thermal expansion. If the
idle stop setting allows the throttle blade(s) to
completely close and contact the throttle bore, the
blade(s) may bind while cold. If the idle stop setting
forces the throttle blade(s) to stay open too far, the IAC
system can lose control and set a diagnostic code.
Either case can result in starting and idle stability
problems.

Issues with throttle blade, linkage or cable
binding are often encountered with installation of an
aftermarket throttle body. Verify that the throttle system
operates smoothly, that the take up cable has some
slack, and that the return cable forces the throttle
blade(s) against the idle stop. Verify that the throttle
blade(s) do not bind when cold or hot.

If an initial adjustment is required for a new
aftermarket throttle body and the manufacturer does
not make a specific recommendation, set the idle stop
screw so that the throttle blade(s) just barely open and
do not bind when the engine is cold.

The IAC actuator and wire harness connections
changed on 2006 and later models. If you install an
aftermarket throttle body on 2006 and later models and
reuse the original equipment IAC actuator, you will not
encounter any problems. If the aftermarket throttle
body requires the earlier style actuator, you must swap
the wires going to pins A and C. If you install the new
50mm Screamin’ Eagle® throttle body (P/N 27623-05)
on a 2001-2005 model, you must swap the wires going
to pins A and C on the IAC actuator. Incorrect IAC
connections will cause idle speed control to fail. This
will result in erratic engine operation and the ECM
setting IAC related diagnostic codes.

IDLE TPS CHECK & ADJUSTMENT

Proper operation of the TCFI system depends
on an accurate throttle position sensor (TPS) signal.
You can use TCFI Log software to check the TPS
sensor. Read the Idle TPS Display section on page 36
before proceeding.

Connect the USB interface cable and start TCFI
Log. Turn the run/stop switch on but do not start the
engine. For TCFI Log, use the View Idle TPS
command on the View menu. Idle TPS volts are
displayed on the TPS bar graph gauge. With the
throttle closed, the TPS value must be within the range
of .30-.80 volts.

Some aftermarket throttle bodies are supplied
with undercut screws that facilitate TPS sensor
adjustment. If you need to make an adjustment and
you do not have the undercut screws, you will have to
enlarge the holes and then use #8 flat washers with the
original screws. For 2001-2005 TPS sensors,
carefully drill out or press out the brass bushings. For
2006 and later TPS sensors, cut the plastic alignment
tab off the back of the sensor to allow adjustment.

Do not attempt to substitute the older style
Marelli TPS sensor. While the older style TPS sensor
has screw slots that provide easy adjustment, it has a
different output characteristic.

ENGINE STARTING PROCEDURE

With alpha-N fuel control, the proper engine
starting procedure must be followed. When the
run/stop switch is turned on, the TCFI reads the TPS
voltage to establish zero percent throttle position. If the
throttle is not fully closed at this point, all subsequent
fuel control will be incorrect.

The throttle body is affected by thermal
expansion. If the engine has cooled down or the
motorcycle has sat overnight, we suggest that you
momentarily open and then release the throttle before
turning the run/stop switch on. Make absolutely sure
that the throttle is fully closed before turning the
run/stop switch on.

The throttle friction adjustment screw may
prevent the throttle from fully closing. We suggest that
you always leave this screw fully counterclockwise.

When the run/stop switch is turned on, the idle
air control motor will move to the starting position and
the fuel pump will be energized for several seconds,
making an audible buzz. Do not press the starter
button until the check engine light goes out and the fuel
pump stops buzzing.

When you turn the run/stop switch off, the idle
air control motor requires several seconds to return to
its home position. After turning the run/stop switch off,
you must wait for 5 seconds before turning the switch
on again. If the engine stalls, we suggest that you cycle
the run/stop switch off for 5 seconds and then on again
before attempting a restart.
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We recommend that you let the engine idle for
about 20-30 seconds before operating the motorcycle.
This allows the closed loop idle air control system to
stabilize idle RPM.

If you make any changes or adjustments to the
throttle body, disconnect the battery, swap out the
TCFI unit, or upload new data or firmware, you must
also cycle the run/stop switch, as explained above, in
order to properly initialize the idle air control motor.

IDLE TUNING

Some applications will require adjustment of the
idle stop screw. This should be completed before the
motorcycle is driven.

Please note that during the initial period after
engine start, fuel control is open loop (no feedback
from the WEGO sensors) and relies entirely on correct
values in the Alpha-N table. The TCFI will enter closed
loop AFR control mode after the WEGO warm up time
(nominal value of 30 seconds) has elapsed.

To allow viewing and logging AFR data
immediately after engine start, turn the ignition switch
on but leave the run/stop switch in the stop position.
Wait at least 15 seconds for the WEGO sensors to
warm up and then start the engine. Monitor engine
data and status with TCFI Log software.

Allow the engine to idle until it reaches normal
operating temperature of 110° C or 230° F. A fan
should be used to direct cooling air on the engine to
more realistically simulate actual warm up conditions
and prevent the engine from overheating. If the engine
does not start or stalls, please refer to the diagnostic
tips at the end of this section on page 7.

Monitor front and rear cylinder AFR and BLM,
engine temperature, and IAC values. Keep notes on
your observations of these values. After 30 seconds,
the system should be operating in closed loop and
maintaining the desired idle AFR (nominal value of
13.5). The BLM values should remain within the range
of 80-120%. The IAC value should slowly go down as
the engine reaches operating temperature and requires
less idle air.

BLM values below 100% indicate that the TCFI
is removing fuel in closed loop to correct a rich
condition. BLM values above 100% indicate that the
TCFl is adding fuel in closed loop to correct a lean
condition.

If the BLM values go below 80% or above 120%
anytime during the warm up period, the system is
running out of adjustment range and the idle cells in

the Alpha-N fuel table should be edited before
proceeding with further tuning.

Download the current setup with PC Link TCFI
software and use the Edit 3D Table — Alpha-N Table
command to edit the idle cells in the Alpha-N fuel table.
Depending on engine temperature, IAC value and idle
RPM, the TCFI will be using the cells in the 750, 1,000,
1,250, and 1,500 RPM columns and the 0%, 2.5% (IAC
between 50-80), and 5% TPS (IAC above 80) rows.
You can select all these cells, right click the mouse,
and then use the Modify command on the pop-up
menu. Add a percentage corresponding to the BLM
error. For example, if the worst case BLM value noted
was 120%, add 20% fuel by entering +20% (not +20).
Likewise, if the worst case BLM value was 80%,
subtract 20% fuel by entering -20%. Remember to use
the Save Table Edits to Buffer command after editing
the table. Then use the Edit 3D Table — BLM Tables —
Reset BLM Tables command to reset all BLM values to
100%. Save the edited setup file to disk and upload it
to the TCFI.

As mentioned above, the IAC value should
slowly go down as the engine reaches operating
temperature. The IAC value should drop to near the
nominal value of 30 (as set under basic module
parameters). If the IAC value stays above 40 or drops
below 25, the idle stop screw will require adjustment
before proceeding with further tuning. Stock Delphi®
and Screamin Eagle® throttle bodies may require
drilling out and retapping the idle stop screw.

Some “trial and error” adjustments to the idle
stop may be required to obtain the nominal IAC value.
Turn the engine off and let it cool down between
adjustments. If the IAC position is too high, turn the idle
stop screw clockwise in ¥z turn increments between
trials to allow more air to flow through the throttle
blade(s). Please note that if you make any
adjustment to the idle stop screw, you must also
recheck (and possibly re-adjust) the idle TPS
setting as explained in the previous section.

CAUTION: Failure to perform required
TPS and idle stop adjustments is a
leading cause of installation problems
requiring tech support.

After making any required edits and idle
adjustments, repeat the start test and allow the engine
to reach normal operating temperature. Make sure the
engine runs for at least 5 minutes and the status
display shows warm closed loop operation —
otherwise BLM values will not be saved.
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The idle tuning step is complete when BLM
values stay within the range of 85-115% during the
warm up phase and the IAC value is within the range
of 25-40 once the engine reaches normal operating
temperature. If these criteria cannot be met, please
contact our tech support before proceeding.

For additional idle tuning information, please
download the TCFI Idle Tuning Tech Note.

Diagnostic tips if the engine does not start:

1. Verify that the TCFl is properly installed and set
up, that the battery is fully charged, that the IAC
system is initialized (cycle run/stop switch), and
that the engine is not flooded from excessive
priming caused by repeatedly cycling the run/stop
switch during setup. Disconnect the fuel pump
relay and crank the engine to clear flooding.

2. Try the following starting procedure: set the
run/stop switch to run, wait until the fuel pump
stops running, slightly open the throttle, and then
press the starter switch. If the engine starts, the
problem is insufficient air caused by an incorrect
idle stop setting. Try turning the idle stop screw
clockwise in %2 turn increments between trials.

3. Ether starting spray can be used as a diagnostic
aid. Try starting the engine after an application of
ether spray. If the engine starts and momentarily
runs at an abnormally high idle RPM, the problem
is excessive air caused by an incorrect idle stop
setting. Try turning the idle stop screw
counterclockwise in % turn increments between
trials. Otherwise, if the engine starts and runs at a
normal idle RPM, the problem is insufficient fuel.
Try increasing the priming and cranking fuel values
by 10-20%. Download the current setup with PC
Link TCFI software and use the Edit 2D Table — ET
Based Priming Fuel Table and ET Based Cranking
Fuel Table commands. Select all cells, right click
the mouse, use the Modify command on the pop-
up menu, and enter +10% (not +10). Remember to
use the Save Table Edits to Buffer command after
editing each table. Save the edited setup file to
disk and upload it to the TCFI. Retest and repeat if
additional fuel seems to be required.

4. |If larger fuel injectors were installed, cranking and
priming fuel values may need to be decreased. Try
decreasing the priming and cranking fuel values by
20%. Download the current setup with PC Link
TCFI software and use the Edit 2D Table — ET
Based Priming Fuel Table and ET Based Cranking
Fuel Table commands. Select all cells, right click
the mouse, use the Modify command on the pop-
up menu, and enter -20% (not -20). Remember to

use the Save Table Edits to Buffer command after
editing each table. Save the edited setup file to
disk and upload it to the TCFI.

Try re-installing the stock ECM. Cycle the run stop
switch to re-initialize the IAC system. If the engine
does not start with the stock ECM, there may be an
underlying problem that requires correction. If the
engine starts with the stock ECM but not the TCFI,
please contact our tech support for assistance.

Diagnostic tips if the engine stalls:

1.

If the engine momentarily starts, runs for several
revolutions (less than 2 seconds), and then stalls,
priming and cranking fuel values may be
insufficient to build up the required fuel film in the
intake manifold. Try cycling the run/stop switch
several times to add additional priming fuel before
starting the engine. If the engine starts normally,
you have confirmed that more fuel is required. Try
adding 10-20% more priming and cranking fuel as
explained in Paragraph 2 in the preceding section.

If the engine stalls after running for several
seconds, observe AFR values. To do this you must
allow the WEGO sensors to warm up for at least
15 seconds before starting the engine. You can
observe data in real time or download data logged
using TCFI Log. For best results, select the 10
samples/sec download option. In most cases, the
problem is caused by excessively lean AFR. Based
on observed AFR values, make appropriate
corrections to the idle cells in Alpha-N table. If the
AFR is lean, try adding 10-20% fuel (use the
procedure explained on page 6). If this does not
solve the problem, please contact our tech support
for assistance.

In some cases, changes to the cold start
enrichment tables may be required. The new
firmware and software support independent ET
(engine temperature) based front and rear cylinder
cold start enrichment tables. To allow viewing and
logging AFR data immediately after engine start,
turn the ignition switch on but leave the run/stop
switch in the stop position. Wait at least 15
seconds for the WEGO sensors to warm up and
then start the engine. Monitor engine data and
status with TCFI Log. Download the logged data.
Compare the front and rear AFR values after
engine start to determine if adjustments are
required. Refer to the TCFI Idle Tuning Tech Note
for more details.
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AUTO-TUNING

The closed loop auto-tuning process consists of
operating the motorcycle through a wide range of loads
and speeds while periodically monitoring progress
using the PC Link TCFI software. Long rides at
constant speed and load are of no value. The best
technique is to very slowly accelerate through the
useable RPM range in every gear, allowing several
seconds of operation in each RPM and throttle position
based cell. Also operate the motorcycle at various fixed
speeds likely to be encountered during normal riding.
For safety reasons, wide open throttle runs should be
done on a closed course.

We recommend auto-tuning under actual riding
conditions. If this is not possible, you can auto-tune on
a load control dyno and use TCFI Log to monitor AFR
and other engine parameters.

If AFR values appear very lean (above 14.5), we
suggest that you edit the Alpha-N table to add 15-20%
fuel to all cells except idle cells before proceeding.
Auto-tuning works best if you start with a slightly rich
Alpha-N table. Download the current setup with PC
Link TCFI software and use the Edit 3D Table — Alpha-
N Table command. You can select groups of cells,
right click the mouse, use the Modify command on the
pop-up menu, and enter +15% (not 15). Remember to
use the Save Table Edits to Buffer command after
editing each table. Save the edited setup file to disk
and upload it to the TCFI

After 1-2 hours of engine operation, download
the current setup with PC Link TCFI software and use
the Edit 3D Table — BLM Tables — Edit Front and Edit
Rear BLM Table commands to examine the BLM
tables. Cells that are shaded red indicate that the
system has run out of correction range. Then use the
Apply Front and Apply Rear BLM Table commands to
automatically correct the Alpha-N fuel table and front
cylinder trim table. This also resets all the BLM values
back to 100% and allows auto-tuning to continue. Save
the edited setup file to disk and upload it to the TCFI.

Auto-tuning is a statistical process. The longer
the operating time, the greater the probability that more
cells will be covered. However, even a varied operating
cycle can miss some cells. After you use the Apply
BLM Table commands, take some time to examine the
modified Alpha-N and front cylinder trim tables. Unless
your engine has some unusual camshaft and exhaust
interactions, the tables should appear smooth (with

gently rising slopes). If you spot sharp spikes or dips,
these cells have probably been missed during auto-

tuning and will require some manual edits to smooth
them into the surrounding terrain.

The Alpha-N table represents percent injector
pulse width (fuel flow) before correction for BLM, front
cylinder trim, barometric pressure, intake temperature,
and cold start enrichment. You can use the following
guidelines to smooth the Alpha-N table:

1. At part throttle (low TPS%), Alpha-N values in each
row will tend to decrease as RPM increases
(because the throttle is choking air flow).

2. At wide open throttle, Alpha-N values in each row
will tend to follow the engine torque curve.

3. Inany given RPM column, Alpha-N values must
always increase with TPS.

The front cylinder trim table may appear more
complex and irregular, with peaks and valleys
corresponding to gas flow interactions within the intake
and exhaust system. However, very sharp spikes and
dips may require some smoothing.

If you edit the Alpha-N or front cylinder trim table
to smooth out values, remember to use the Save Table
Edits to Buffer command after editing each table. Save
the edited setup file to disk and upload it to the TCFI.

Continue to operate the motorcycle under
varying conditions for another 1-2 hours. Then repeat
the process of downloading setup data, examining the
BLM tables, using the Apply BLM Table commands,
smoothing the Alpha-N and front cylinder trim tables,
saving, and uploading back to the TCFI as previously
described.

Continue this auto-tuning process until most of
the BLM cells remain in the 90-110% range.

If spark knock is noted under wide open throttle
or throttle roll-on, use PC Link TCFI software to edit the
ignition advance table and reduce the ignition advance
3-5 degrees under the conditions that cause spark
knock. Using the TCFI Log software to examine engine
data may be very helpful for determining exactly what
manifold pressure and RPM values were encountered.
A common error is to assume spark knock only occurs
at high MAP (manifold absolute pressure) values.
Large displacement engines are prone to spark knock
at relatively low MAP values during throttle roll-on. You
may need to reduce the ignition advance throughout
the entire MAP range.
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CAUTION: During auto-tuning, BLM
values are only saved if the engine
reaches 95° C (200° F) and runs for at
least 5 minutes. This is set by warm
engine temperature and engine warm-
up time parameters (refer to page 29).
In cold climate areas, you may have to
use a lower value for warm engine
temperature.

FUEL INJECTOR SIZING

Accepted engineering practice is to use the
smallest possible injectors (in terms of flow) for best
control at idle and part throttle. The Delphi® style single
throttle body and similar aftermarket units with
siamesed runners are subject to fuel imbalance
problems between the front and rear cylinders. When
the fuel injector duty cycle exceeds 50%, fuel will start
being inducted into the wrong cylinder (i.e. front
injector spraying fuel while rear intake valve is still
open). The TCFI system cannot correct this
problem. Aftermarket throttle bodies with dual
independent runners do not suffer from this problem
and the fuel injectors can be run up to 80% duty cycle.
At high duty cycles, fuel may puddle up in front of the
intake valve but will ultimately be inducted into the
correct cylinder.

WARNING: H-D® has issued Service
Bulletin M-1185. Most 2006 models
have narrow 8° spray pattern injectors
(P/N 27625-06) that cause poor cold
start, idle, and cruise. The replacement
injectors (P/N 27709-06A) have a 25°
spray pattern. Verify that the injectors
have been replaced. The TCFI will not
operate correctly with the original
injectors.

Stock Delphi® injectors are rated at 3.91 or 4.22
gm/sec flow depending on model year. Table 1 lists
conservative horsepower limits based on injector size
and type of throttle body. You can use TCFI Log
software to check the injector duty cycle at wide open
throttle.

Table 1 — Recommended Horsepower Limits

Injector Size Siamesed Dual Runners
Runners

3.91 gm/sec (stock | 90 HP Not available

2006 and later P/N

27709-06A)

4.22 gm/sec (stock | 100 HP 135 HP

2001-2005)

4.89 gm/sec 110 HP Not available

Screamin Eagle®

P/N 27654-06)

6.0 gm/sec 130 HP 195 HP

WARNING: If you significantly exceed
these horsepower limits, the result may
be alean cylinder and possible engine
damage at high RPM wide open throttle.

LARGE DISPLACEMENT ENGINES

For large displacement engines and/or higher
flow injectors, you can modify one of the 95 or 96 CID
setup files by editing the module parameters and
entering appropriate values for the estimated
horsepower and injector flow rate.

The TCFI has been successfully applied to
engines as large as the S&S Cycle 145 Tribute.
Engines over 103 CID may require additional tuning
procedures. Please contact our tech support for
details.

The dimensions of the IAC pintle and idle air
ports on currently available throttle bodies may not
allow sufficient airflow for starting 120 CID and larger
engines at low ambient temperatures. In this case, the
customer must be instructed to use the following cold
weather starting procedure: set the run/stop switch to
run, wait until the fuel pump stops running, slightly
open the throttle, and then press the starter switch.

The stock starting system is inadequate for high
displacement, high compression engines. For these
applications, you must install compression releases
and upgrade the starter, ring gear/pinion, and battery.
Based on customer feedback, the best available
starting system is the combination of a Tech Cycle 2.0
KW Tornado starter, Rivera Engineering 84 tooth ring
gear/pinion set, and Yuasa YuMicron CX battery.
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THROTTLE BODY AND INTAKE
RECOMMENDATIONS

95 CID or higher displacement engines will
require an aftermarket throttle body and low restriction
air cleaner for maximum performance. We recommend
a throttle body with at least 50 mm ID. Smaller throttle
bodies or modified stock throttle bodies will not allow
sufficient air flow at high RPM. This can be verified by
examining MAP (manifold pressure) during a dyno run
with TCFI Log software.

Front cylinder fuel imbalance may become
intolerable with large displacement engines unless a
dual independent runner intake and throttle body
system is used. We have tested BC Gerolamy Dual
Flow and S&S Cycle VFI Induction systems. If you plan
on using another dual runner type system, please
contact our tech support before proceeding.

BC GEROLAMY DUAL FLOW
THROTTLE BODY

Follow the installation instructions supplied with
the throttle body. You can use the stock Delphi®
injectors for applications up to 135 HP. Use the setup
file TCFI_Setup_2001_Gerolamy.dat. This setup file is
intended for a 95 CID engine. For large displacement
engines, you can modify this setup file by editing the
module parameters and entering an appropriate value
for the estimated horsepower and injector flow rate.

S&S CYCLE VFI INDUCTION
SYSTEM

The TCFI has been successfully retrofit on many
problematic VFI systems. VFI systems are supplied
with various fuel injectors. Contact S&S Cycle for
information on the injector size supplied with your
system. Follow the installation instructions supplied
with the VFI system, with the following exceptions:

1. Some early production units have undersize idle air
ports. All idle air ports leading to and from the IAC
control must be at least 0.312” diameter. If
required, mill ports to 0.312” diameter in a
Bridgeport mill (do not attempt to use a drill). Tilt
the milling machine head to match the angles of
the idle ports. Remove the TPS sensor to facilitate
clamping the throttle body in a vise.

2. When installing the VFI Induction, disregard the
S&S Cycle instructions related to idle stop and
TPS adjustment. Follow the procedures we give on
page 5.

3. Carefully check wiring connections. All OE H-D®
signals (refer to H-D® Electrical Diagnostic Manual)
must be connected. Common problem areas
include failure to connect the vehicle speed sensor
(VSS) signal. Some VFI applications did not use a
manifold absolute pressure (MAP) sensor. The
TCFI requires a MAP sensor ported to the front
cylinder intake runner.

4. Use the setup file TCFI_Setup_2001_VFIl.dat. This
setup file is intended for a 95 CID engine and the
S&S Cycle 4.6 gm/sec injectors commonly
supplied with the VFI Induction System. You can
modify this setup file by editing the module
parameters and entering an appropriate value for
the estimated horsepower and actual injector size.

IDLE TUNING CONSIDERATIONS

Some large displacement engines with high
overlap/long duration camshafts may not idle properly
at the nominal 1,000 RPM and 13.5 AFR settings used
in the standard setup files. You may have to increase
the idle RPM to a higher value such as 1,100 RPM and
enrich the idle to 12.5-12.8 AFR.

Download the current setup with PC Link TCFI
software and use the Edit 2D Table — ET Based Idle
RPM command to increase the idle RPM. Do not
decrease values at the left of the table (corresponding
to a cold start condition) that are already higher than
your desired idle RPM. If you significantly increase idle
RPM, you may also have to make corresponding edits
to the ET Based IAC Position table. Please contact our
tech support for details.

Then use the Edit 3D Table — AFR Table
command and change the applicable idle cells (750 -
1,500 RPM at 0-5% TPS) to the desired AFR value.
Remember to use the Save Table Edits to Buffer
command after editing each table. Save the edited
setup file to disk and upload it to the TCFI.

For additional idle tuning information, please
download the TCFI Idle Tuning Tech Note.

DYNO TUNING CONSIDERATIONS

Auto-tuning using the procedures listed on page
8 will get you within a few horsepower of the maximum
that the engine can deliver. If you decide to do dyno
tuning for maximum power, you can experiment with
wide open throttle (WOT) ignition timing and AFR.
Please pay careful attention to the following dyno
tuning considerations:

1. Only edit the ignition advance and AFR tables.
Don’t edit any other tables (never make any
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changes to the BLM or Alpha-N tables once auto-
tuning is completed). The usual range for WOT
ignition timing at 4,000-6,000 RPM is about 28-34
degrees BTDC. The usual range for WOT AFR is
about 12.5-12.8. Some engines may require a
richer mixture, possibly down to 11.5, to avoid
detonation problems.

2. The TCFl should be operated in closed loop.
Make sure that the engine is warmed up (olil
temperature is in the 150-180° F range) before
doing a run and that engine status in TCFI Log
shows closed loop operation. If you have made
any table edits, allow one run for auto-tuning
before capturing data.

3. Inadequate air flow for engine cooling is a
major problem with many dyno systems.
Always let the engine cool off between dyno runs.
The use of a separate heavy duty industrial grade
fan capable of generating at least 50+ MPH air
velocity at the front of the engine is recommended.
You can measure the air velocity with a handheld
anemometer such as Extech P/N 45118 available
from Grainger.

4. Usethe TCFIl data logging capability. Always
download data with TCFI Log software at the end
of every run and study the results (use the 10
samples/sec download option). Check engine and
air temperatures, throttle position, manifold
pressure, and AFR. TCFI Log is a very powerful
tool that can help you identify potential problems
that may be affecting engine performance.
Inconsistent dyno test results are often the result of
thermal problems (engine temperature variations
or hot soak effects).

5. Dyno exhaust sniffer limitations. Some of the
older sniffers monitored CO and COz. These
systems are so slow and inaccurate that they
should be totally disregarded. Modern sniffers from
Dynojet and Horiba use a wideband sensor similar
to the WEGO sensor. These sniffers are still
subject to erroneous lean readings caused by
reversion of atmospheric oxygen if the probe
cannot be inserted past the baffles in the exhaust.
Sensor degradation caused by leaded racing gas
is a common occurrence. Another problem is
sampling delay due to the long hose between the
sniffer tip and actual sensor. The bottom line is to
trust your WEGO sensors and disregard any errant
readings from an exhaust sniffer.

ENGINE TUNING GUIDELINES

Higher AFR values correspond to a leaner (less
fuel) condition. The practical operating range for most
engines using gasoline fuel is from approximately 11.5
to 14.7 AFR. Combustion of a stoichiometric mixture
(exactly enough air to burn all the fuel) results in 14.7
AFR indication. Automotive engines with catalytic
converters operate near 14.7 AFR during cruise and
idle. Air-cooled motorcycle race engines usually
require a richer mixture to limit cylinder head
temperature and prevent detonation. Table 2 lists
recommended AFR values for race engines without
emission controls.

Table 2 — Recommended AFR Values

Operating Mode Recommended AFR

Cold Start (first 30 sec) | 11.5-12.5
Idle 12.8-13.5
Part Throttle Cruise 13.0-14.0

Wide Open Throttle 12.5-12.8 (values down
to 11.5 may be used to

reduce detonation)

EXHAUST CONSIDERATIONS

The use of a WEGO system for closed loop fuel
control places constraints on the choice of exhaust
system. The WEGO system may give inaccurate
results in certain situations:

Exhaust reversion. Reversion is the term for a
negative pressure wave that can suck ambient air back
into the exhaust and cause an erroneous lean AFR
indication. Open drag pipes suffer from reversion
effects. Please note that if you use drag pipes or other
open pipes, auto-tuning may not be possible at idle or
part throttle due to reversion effects. In this case, you
have three options:

1. Modify the exhaust to allow auto-tuning at idle and
part throttle by adding a restriction such as the
washers shown in Figure 1 or some other type of
baffling. For race applications, you can remove the
restriction after auto-tuning the idle and part throttle
cells and then lock out closed loop operation by
using the special value 0 in the BLM tables for
these cells.

2. Use arubber hose to extend the exhaust length
during auto-tuning at idle and part throttle. For
more information, please contact our tech support.
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3. Manually tune the fuel tables for idle and part
throttle cells. This involves trial and error and is not
recommended. Closed loop operation in idle and
part throttle cells must be locked out by using the
special value 0 in the BLM tables for the affected
cells.

WARNING: If you can insert a
broomstick through the mufflers, you
have the equivalent of open drag pipes
and the WEGO sensors will not read
accurate AFR values, except at wide
open throttle.

You can reduce reversion effects in open drag
pipes and mufflers without restrictive baffles with the
modification shown in Figure 1. Use washers with an
OD that is 2/3 to 3/4 the ID of the pipe (for example, 1-
1/2” OD washers are suitable for pipes with an ID of 2”
to 2.25”). Weld V4-20 socket head cap screws to the
washers as shown. Drill holes at the bottom of the
pipes about 2” from the end and use decorative acorn
nuts to secure the washer assemblies. We suggest
that you use stainless steel hardware.

The washers will reflect positive pressure waves
that will cancel out the negative pressure waves
reflecting from the end of the pipes. You can turn the
washers just like throttle blades to provide more or less
restriction. Dyno tests will show a significant increase
in midrange torque and a small drop in top end
horsepower as the restriction is increased.

Figure 1 — Exhaust Mod to Reduce Reversion

>\

Reversion effects will also occur with certain
exhausts used on “bagger” style motorcycles, where
two pipes split off near the rear cylinder. At part
throttle, air is actually sucked into the left tailpipe. The
only solution is to install a true dual type performance
exhaust. Reversion effects will be most noticeable at
idle, part throttle low RPM cruise, and decel.

Excessive scavenging. Tuned exhausts in
combination with a high overlap camshaft profile can
pull unburned air and fuel mixture through the cylinder
into the exhaust and cause an erroneous rich AFR
indication. Some aftermarket 2-into-1 systems, such as
the Thunderheader appear to suffer from this problem,
whereas others such as the Supertrapp, Vance &
Hines Pro Pipe and White Brothers E-series seem less
affected.

Misfiring. If the AFR is so rich that the engine
misfires, high levels of oxygen will remain in the
exhaust gas and result in an erroneous lean indication.

CAUTION: Insistence on using an
inappropriate exhaust and consequent
failure of auto-tuning is a major cause
of installation problems requiring tech
support.

HOT STARTING PROBLEMS

Some engines are prone to hot starting
problems. When cranked after a short hot soak, the
engine may “kick back.” Over time, this will cause
damage to the ring gear and starter pinion.

The TCFI module uses an improved starting
algorithm that includes a programmable cranking
delay. The TCFI module is shipped with a zero
cranking delay: it fires on the first recognized
compression stroke. This works best on stock and
mildly modified engines.

High compression engines will generally require
compression releases. When compression releases
are installed, best starting results will be obtained by
programming the TCFI module for a 1-2 revolution
cranking delay. This can be done by means of the PC
Link TCFI software.

SPARK KNOCK PROBLEMS WITH
HIGH COMPRESSION ENGINES

Spark knock problems may be encountered with
high compression engines. If engine parts were “mixed
and matched” from different suppliers, the actual
compression ratio may differ substantially from the
expected value. You cannot estimate compression
ratio with cranking compression tests, as camshaft
timing usually causes an erroneous low reading.

To accurately calculate compression ratio, you
must measure the combustion chamber volume and
use the formula:
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Compression = (Head cc + Deck cc + Cylinder Volume)
Ratio (Head cc + Deck cc)

The practical limit for compression ratio is about
10.5:1 to 11:1 when running 93 octane pump gas. Any
higher compression ratio will require retarding the
ignition timing to the point where more power is lost
from the retarded timing than is gained from the higher
compression.

If spark knock is encountered during operation,
you can use the TCFI Log software to download data
and examine the operating conditions (RPM and
manifold pressure) where spark knock occurred. You
can then make appropriate reductions to the ignition
advance table. Large displacement, high compression
engines are prone to spark knock at relatively low MAP
values during throttle roll-on. You may need to reduce
the ignition advance throughout the entire MAP range.

ACR SYSTEM ON 2007 AND LATER
MODELS

CVO engines on some 2007 and later models
are equipped with an automatic compression release
(ACR) system. The TCFI Gen 4 supports the ACR
system. No modifications or other special
considerations are required. The ACR output on pin 15
is active during the cranking revolutions set under
Module Parameters (refer to page 28) if this parameter
is set to a non-zero value.

USER FUNCTIONS

The TCFI user input on pin 16 can be connected
for a stage RPM limit function as shown in Figure 2.
The stage limit switch must be normally open. You can
use a microswitch attached to the clutch lever. When
the clutch lever is pulled in, the switch contacts should
close to activate the stage RPM limit. Refer to the User
Functions section on pages 31-32 for details on
programming the stage RPM limit.

Figure 2 — Stage Limit Switch Wiring Diagram

STAGE LIMIT SWITCH OPERATION:
SWITCH OPEN - MAXIMUM RPM LIMIT
SWITCH CLOSED - STAGE RPM LIMIT TCFI
AL_@i PIN 16 (USER INPUT)
TO GROUND

The TCFI user output on pin 22 can drive a
standard automotive relay connected as shown in
Figure 3. When the user output is active, +12V power

is applied to the load. Refer to the User Functions
section on pages 31-32 for details on programming the
user output.

Figure 3 — User Output Relay Wiring Diagram

TO +12V A
TCFI -
87
PIN 22 (USER OUTPUT) I 30 I
86 85| 12V STANDARD
AUTOMOTIVE
RELAY
——>> TO LOAD

CUSTOM BIKE CONSIDERATIONS

The TCFI can be used for custom bike
applications. The TCFI also has special features to
accommodate aftermarket speedometers and
tachometers, even on 2004 and later H-D® models with
the J1850 data bus. The TCFI does not require the
presence of a turn signal/security module
(TSM/TSSM). However, it does require all the engine
sensors and actuators used with a standard H-D®
application, including a vehicle speed sensor (VSS).
Prior to installation on a custom bike, we suggest that
you contact our tech support. Improper wiring
connections, with missing or incorrect signals, are the
most common problem encountered with custom bike
applications.

Like the Delphi® module, the TCFI sends RPM
data to the instrument module over the J1850 data bus
for 2004 and later models. The TCFI also has a tach
signal available on pin 3 of the 36 pin ECM connector.
This is a one pulse per revolution (PPR) 12 volt square
wave signal with 50% duty cycle that is compatible with
all standard tachometers and other RPM activated
accessories such as shift lights. 2004 and later models
use the J1850 data bus for communication with original
equipment tachometers, however the tach signal on
pin 3 can still be used if you are installing an earlier
style H-D® or aftermarket tach. Note that the
tachometer is never connected to the coil. If your
motorcycle was not originally equipped with a
tachometer and you need hookup instructions or the
tachometer is inoperative, refer to the motorcycle
service manual for more information.

2001-2003 models have the vehicle speed
sensor (VSS) connected to the speedometer. A VSS
signal is routed from the speedometer to pin 33 on the
36 pin ECM connector. The J1850 data bus is used to
send distance data to the turn signal/security module
(TSM/TSSM) for turn signal cancellation. On 2004 and
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later models, the VSS is connected direct to pin 33 on
the ECM. Speed and distance data is sent on the
J1850 data bus to the speedometer and TSM/TSSM.

For all model years, the ECM requires a valid
VSS signal for idle RPM control and turn signal
cancellation. If you plan to install an aftermarket
speedometer, you must maintain the VSS signal to the
ECM. For 2004 and later models, you can try
connecting the VSS input on the aftermarket
speedometer to the existing VSS signal on pin 33
(leave the existing VSS ground and power connections
undisturbed). After completing the hookup, you should
test drive the motorcycle, download data with TCFI Log
software, check VSS data, and verify that the ECM is
still receiving a valid VSS signal. If the speedometer
does not function with this hookup, it is not compatible
with a fuel injected application.

TECH SUPPORT

If you require tech support for tuning issues, we
will ask you to email us both the current setup file
(downloaded by means of PC Link TCFI) and a data
logging file (downloaded by means of TCFI Log) that
shows the problem. The data logging files are large
and tend to be corrupted when attached to an email.
You must use an archiving program such as PKZIP
or WinZip to compress the files prior to attaching
them to an email. You can send email to
techsupport@daytona-twintec.com. Please make sure
that you include your full name, phone number,
complete information about the engine setup, and a
detailed description of the problem. We suggest that
you call us first to discuss the situation.

UPGRADES AND KNOWN ISSUES

The TCFI controller can be upgraded in the field
by the user. Operating firmware is stored in FLASH
memory and new firmware can easily be uploaded by
means of the USB interface cable. We suggest you
periodically check our website at
www.daytona-twintec.com for upgrades to the TCFI
firmware and accompanying PC based software.

As of the shipment date, there are no known
issues other than those listed below.

Possible firmware corruption during dyno
test. We suggest that you do not connect the USB
interface to any PC running Dynojet WinPEP software.
Use a separate PC, such as a laptop with isolated
ground. There appears to be a serial port conflict or
noise issue from the Dynojet ignition pickup.

ENGINE DIAGNOSTICS

The TCFI Gen 4 version has extensive
diagnostics. When the ignition switch is first turned on,
the check engine LED illuminates. The LED goes out
when the system initialization is complete.

If a diagnostic fault is detected while the engine
is running, the LED will illuminate. Diagnostic codes
can be read and cleared by means of the speedometer
(same as with the OE ECM) or TCFI Log software.
Most of the diagnostic codes are the same as those
used by H-D® and the H-D® Electrical Diagnostic
Manual for your model should be employed as a
primary troubleshooting reference. Certain diagnostic
codes that are unique to the TCFI or require special
consideration are listed below:

P0373 CKP Signal Lost. This code will appear
if the engine stalls. Customers are often
confused about the meaning of the term “trips”
associated with codes, especially P0373. This is
an industry standard terminology. If code P0373
shows 40 trips, it means that the code was set
40 engine start cycles ago, not that the code has
been set 40 times and that the crankshaft
position sensor is defective.

P0122 TPS Low or P0123 TPS High. If these
codes appear on a new installation, the TPS idle
adjustment is probably incorrect. Refer to page 5
for detalils.

P0505 Loss of Idle Speed Control. If this code
appears on a new installation, the throttle body
idle stop setting is probably incorrect. Refer to
page 5 for details.

P0132 Rear Oxygen Sensor High, P0134 Rear
Oxygen Sensor Low/Open, P0152 Front
Oxygen Sensor High, or P0154 Front Oxygen
Sensor Low/Open. These codes indicate a
problem with the WEGO IID unit. P0134 and/or
P0154 will be set if the WEGO signal connection
(white and blue wires) or WEGO power is lost.
These codes may also be set if a Bosch sensor
fails or becomes contaminated by leaded
gasoline.

REINSTALLING THE DELPHI®
CONTROLLER

If you reinstall the Delphi® controller, turn the
ignition key on and cycle the run/stop switch before
starting the engine. This initializes the idle air control
motor. With the exception of models with OE oxygen
sensors, removal of the white and blue WEGO signal
wires and green PC link jumper wire is not required.
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For models with OE oxygen sensors, you must remove
the WEGO white and blue wires and reinstall the
original oxygen sensor wires at pins 8 and 23.

TROUBLESHOOTING FLOWCHART

Follow the troubleshooting flowchart shown
below. Please note that the troubleshooting
flowchart does not relate to incorrect setup or

tuning issues with new installations. Experience
has shown that most units returned for warranty are
OK and another problem, such as user error including
improper setup or tuning, an intermittent wire harness
connection, or defective coil, fuel injector, or sensor is
later identified.

TCFI Gen 4 System Troubleshooting Flowchart

STARTING POINT

IS PROBLEM

REPLACE TCFI WITH OE MODULE OR
ANQOTHER KNOWN GOOD MODULE.

FIXED?

YES | NO

REINSTALL TCFI

REPAIR UNDERLYING PROBLEM
BEFORE INSTALLING TCFI. REFER
TO MOTORCYCLE SERVICE MANUAL

TURN IGNITION ON. SET ENGINE
SWITCH TO RUN. IS CHECK ENGINE
LED ILLUMINATED?

NO | YES
REPLACE TCFI

]
| DOES ENGINE START?

NO | YES

REPLACE TCFI

DOES CHECK ENGINE LED REMAIN
ILLUMINATED OR ILLUMINATE AFTER
A SHORT TIME?

NO | YES

]

REFER TO ENGINE
DIAGNOSTICS SECTION. FIX
APPLICABLE PROBLEM.

DOES ENGINE STOP OR DROP
GYLINDER AFTER SEVERAL
MINUTES OF RUNNING?

NO | YES

REPLACE COIL.
1S PROBLEM FIXED?

YES NO

DOES ENGINE MISFIRE | DONE | | REPLACE TCFI |
UNDER LOAD?

NO

YES

REPLACE SPARK PLUGS,
SPARK PLUG WIRES, AND COIL
IS PROBLEM FIXED?

DOES ENGINE MISFIRE
AT PART THROTTLE OR
WHILE COLD?

NO | YES

GHECK FOR INGORREGT GOLD
ARSI START SETTINGS OR INTAKE

LEAK. IS PROBLEM FIXED?

YES NO

|DONE | | REPLACE TCFI |
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Table 3 — Setup File Listing

Filename Description

TCFI_Setup_2001_88CID.dat 2001-2005 88 CID engines with stock compression, performance
camshafts, low restriction air cleaner, and low restriction exhaust.
Also use this file for 2006 engines with aftermarket siamesed runner
throttle body.

TCFI_Setup_2006_88CID.dat 2006 88 CID engines with stock compression, performance
camshafts, new style H-D throttle body (inc. SE version), low
restriction air cleaner, and low restriction exhaust.

TCFI_Setup_2001_95CID.dat 2001-2005 95 CID engines with 10:1 or higher compression, high
flow heads, performance camshafts, aftermarket type throttle body
(50mm or greater), low restriction air cleaner, and low restriction
exhaust. Also use this file for 2006 engines with aftermarket single
plenum throttle body.

TCFI_Setup_2006_95CID.dat 2006 95 CID engines with 10:1 or higher compression, high flow
heads, performance camshafts, new style H-D throttle body (inc. SE
version), low restriction air cleaner, and low restriction exhaust.

TCFI_Setup_2001_Gerolamy.dat | 2001 and later 95 CID engines with 10:1 or higher compression,
high flow heads, performance camshafts, BC Gerolamy dual
independent runner throttle body, low restriction air cleaner, and low
restriction exhaust. Call tech support for additional information
before using on 2006 and later applications.

TCFI_Setup_2001_VFI.dat 2001 and later 95 CID engines with 10:1 or higher compression,
high flow heads, performance camshafts, S&S Cycle VFI induction
system, and low restriction exhaust. Call tech support for
additional information before using on 2006 and later
applications.

TCFI_Setup_2007_96CID.dat 2007-2011 96 CID engines with stock compression, performance
camshafts, low restriction air cleaner, and low restriction exhaust.

TCFI_Setup_2007_SPT.dat 2007-2013 Sportster® 1200 engines with stock compression,
performance camshafts, low restriction air cleaner, and low
restriction exhaust. Do not change VSS value in setup file unless
speedometer error is noted.

Note that any existing TCFI Gen 3 setup files can be used without modification for the TCFI Gen 4. Contact
out tech support for assistance with setup files for specialized applications.

For additional tuning files, please refer to the Quick Links page on our website at
http://www.daytona-twintec.com/quicklinks.html
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USB INTERFACE OVERVIEW

The Twin Tec USB Interface P/N 102004 shown
in Figure 4 is supplied as part of the TCFI system to
provide PC connectivity. The USB interface is
compatible with Windows XP/Vista/7/8.

The USB Interface has a switch that selects the
operating mode. The “TC88A And All Others” switch
position is used for communications with the TCFI
system. The unit comes with a connector that mates
with the four terminal Deutsch data link connector
located near the ECM.

Figure 4 — USB Interface

USB INTERFACE INSTALLATION

The Twin Tec USB interface is based on the
FTDI FT232R chip and drivers that allow the unit to
emulate a standard Windows RS-232 COM port.
Updated Windows drivers, installation instructions and
troubleshooting tips are available on the FTDI website
at www.ftdichip.com. Additional information and
troubleshooting tips can be found on the PC Link Tech
FAQ on our website at www.daytona-twintec.com.

A new USB driver that simplifies the installation
process is available. This installs as an executable file,
similar to other Windows programs. The Windows
Found New Hardware Wizard will then detect the USB
device when it is first connected and automatically
install the correct driver without the user having to
browse out.

Before proceeding with installation, shutdown
any other applications that may be running. For
Windows Vista, you must disable the User Account
Control (UAC) during installation. If you are not familiar
with the UAC, please refer to the Vista UAC Tech Note
on our website's PC Link Tech FAQ for details.

1. Make sure your USB interface is not connected to
your PC.

2. From the website, scroll down and click on the
USB Driver link. When the File Download dialog

NOTE: You must set the switch to the correct
position. Use the “TC88A And All Others”
settina for use with the TCFI svstem.

box appears, click on "Run this program from its
current location.” Ignore any security warnings and
click on Yes to continue.

3. After installation of the driver is complete, connect
the USB interface to the PC with the supplied USB
cable. The Windows Found New Hardware Wizard
will appear and complete installation of the USB
interface.

COM PORT CONFIGURATION

After completing the installation steps outlined
above, you must configure the new COM port using
Device Manager.

1. Windows XP: click Start, Settings, Control Panel,
System, Hardware, and then Device Manager.
Windows Vista: click Start, Control Panel, System
and Maintenance, and then Device Manager.
Windows 7/8: Click Start, Control Panel, System
and Security, and then Device Manager. For more
information, visit www.pcsupport.about.com.

2. Scroll down to Ports (COM and LPT). The new
USB interface will appear as a USB Serial Port.
Click on this new port. Click on the Port Settings
tab.

3. Click on Advanced. In most cases the wizard will
have installed your new USB interface as COM5.
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Note the COM port number assigned for your 4. Once you have configured a COM port number for

system. For optimum performance, you should your new unit, make sure that you use this same
also change the BM Options Latency Timer to 2 COM port selection in the Twin Tec software by
msec as shown in the Figure 5. using the Port Setup command from the

Communications menu.

Figure 5 — COM Port Configuration

Advanced Settings for COM5 ? ﬁ|
COM Port Number: -
USB Transfer Sizes
Cancel
Selectlower settings to correct performance problems at low baud rates.
Select higher settings for faster performance. Defaults
Receive (Bytes) 4096 -
Transmit (Bytes): 4096 -
BM Options Miscellaneous Options
Selectlower settings to correct response problems. Serial Enumerator [v
Serial Printer [~
Latency Timer (msec): 2 -
Cancel If Power Off [
Timeauts Event On Surprise Removal [
SetRTS On Close [~
Minimum Read Timeout (msec) 0 - Disable Modem Cil At Startup .
Minimum Write Timeout (msec): 0 -

CAUTION: If communications are interrupted
during PC Link upload or you accidently turn on
the run/stop switch while the USB interface
switch is in the wrong position, the TCFI may
become non-responsive. To completely reset the
TCFI, momentarily unplug the ECM connector.
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PC LINK TCFI OVERVIEW

PC Link TCFI software runs under Microsoft
Windows XP/Vista/7/8. Version 15 of the PC Link TCFI
software supports all TCFI IIl (Gen 3) and TCFI Gen 4
fuel injection controllers. The software allows the user
to program the units with custom ignition and fuel
tables and other engine parameters. The term TCFl is
used throughout this document as a generic term
and refers to the new TCFI Gen 4 version unless
otherwise noted.

After PC Link TCFl is launched, the main screen
appears blank. You have two options for obtaining data
for editing. You can open a previously saved data file
by using the Open File command on the File menu or
you can download data from an attached TCFI unit by
using the Download Data From TCFI command on the
Communications menu. Note that TCFI data files use a
.dat extension. You should create a separate folder to
store these files.

Once you have TCFI data, you can edit various
2D and 3D tables and engine parameters. All 3D tables
are accompanied by chart displays that help visualize
the data. You can also rotate the 3D chart display for a
better view of a particular region. You can print the
data associated with an active table or engine
parameters by using the appropriate Print command
from the File menu. When you open a file or download
data from a TCFI module, the data is stored in a buffer
memory. After editing a table, you can save the edits to
this buffer memory. Once you have completed all your
edits, you can save the data in buffer memory to a file
or upload it back to the TCFI module by using the
appropriate command from the File or Communications
menu.

PC REQUIREMENTS

We recommend a laptop with Pentium processor
and super VGA display (SVGA with 1024 x 768 pixel
resolution) running Windows XP/Vista/7/8. Data chart
display is graphics intensive and a high speed Pentium
processor is recommended. Processors slower than
300 MHz will exhibit sluggish program loading and
response. The PC must have an available USB port.

PC Link TCFI includes print commands that print
table graphics and other engine parameters. The
program has been tested with Hewlett-Packard laser
and inkjet printers and Epson inkjet printers. We
recommend using a color inkjet printer.

SOFTWARE INSTALLATION

The software is in the form of a compressed file
downloaded from our website. The installation process
uses InstallShield. This industry standard installer is
based the new Microsoft Windows Installer service that
greatly reduces potential problems such as version
conflicts and allows for application self-repair.

Before proceeding with installation, shutdown
any other applications that may be running. For
Windows Vista, you must disable the User Account
Control (UAC) during installation. If you are not familiar
with the UAC, please refer to the Vista UAC Tech Note
on our website's Tech FAQ for details.

Use the Windows Explorer to launch the
PC_Link_TCFI setup.exe file downloaded from our
website. InstallShield will install the software in an
appropriate folder under Program Files.

Once InstallShield has completed the
installation, PC Link TCFI will appear on the Windows
Start Menu. You can then launch it just as you would
any other Windows program.

PC Link TCFI requires the Monospace 821 BT
fixed pitch printer font in order to properly align
columns when printing advance tables. The
Monospace 821 BT font is included in the distribution
media and automatically copied to your Windows Fonts
folder during installation. A backup copy is also placed
in the program folder. If you accidentally delete this
font, use the Install New Font command from the Fonts
folder File menu. The filename associated with
Monospace 821 BT is monos.ttf.

DOWNLOADING DATA

The USB interface, P/N 102004, is used for
communication with the TCFI module. No additional
hardware is required. The USB interface connects to
the four terminal Deutsch data link connector that is
part of the WEGO harness (refer to Figure 27 for
details). The USB Interface has a switch that selects
the operating mode. For communication with the TCFI,
you must use the TC88A And All Others switch
position.

Turn the ignition key and engine run/stop
switches on to provide power to the TCFI unit. Do not
start the engine.

If the TCFI unit has been removed from the
motorcycle, you can do bench top programming by
using an adapter harness (P/N TCFI-ADAPT) that
includes a small 12 volt DC power supply.
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The PC Link TCFI program has auto-connect
capability and a COM port scan function to aid in initial
setup of the communications link. You can use the Port
Setup command from the Communications menu to
display the dialog box shown below and select the
correct COM port.

If you are not sure what COM port the USB
interface has been assigned to, you can click on the
Scan button to automatically detect and select the
correct port. Before you do so, make sure that the USB
interface has been connected to your PC and the TCFI
module. Both the ignition key and engine run/stop
switches must be turned on. Once the correct COM
port has been selected, the program will remember this
setting.

If you enable the Auto Connect check box, the
program will try to connect to the TCFI every time the
program is started. Please note that you must have the
correct COM port selected and the USB interface
connected to your PC and the TCFI module. Both the
ignition key and engine run/stop switches must be
turned on in order for auto-connect to work properly.

Figure 6 — Data Port Setup

Data Port Setup

Port Coml h

[ Auto Connect

Scan ‘

Download data by using the Download Data
From TCFI command on the Communications menu.
The program will display the module's firmware ID.

CREATING A NEW IGNITION
ADVANCE TABLE

Use the New Advance Table command on the
Edit, Edit 3D Table, Advance Table menu. A dialog box
appears and allows you to enter initial timing and
advance slope settings. Settings close to 5 result in an
advance table suitable for stock engines. Use lower
values for high compression engines. Each time you
click on Update, the corresponding advance table is
displayed.

You will find the New Advance Table command
useful for generating an advance table that will serve
as a starting point for further edits. When you are ready
to proceed with editing, click on OK. After you have
edited the table, you must use the Save Table Edits To
Buffer command from the Edit menu to save your edits

to buffer memory. If you use the Close Table command
from the Edit menu, all your edits are lost.

Figure 7 - Creating a New Advance Table

W New Advance Table BJ

Initial Timing Advance Slope

Update

Editing Table Data

You can edit table data using standard Windows
copy and paste operations by selecting cells and then
clicking the right mouse button to pop-up the edit
menu. You can select cells by dragging the mouse with
left button down.

Figure 8 — Modify Command

Cancel

Enter a newvalue. See examples below or Help for details.
Enter 30to set all cells in selection to 30
Enter-5 to subitract & from each cell in selection
Enter +10to add 10to each cell in selection
Enter 80% to multiply each cell in selection by 8024
Enter-7.5% to reduce each cell in selection by 7.5%
Enter +15% to increase each cell in selection by 15%

|30]

You can also use the Modify command on the
pop-up menu. When you enter a value, the presence of
optional sign (+ or -) or percent (%) characters affects
the outcome of the Modify command.

Chart Operations

You can rotate the 3D chart display for a better
view of a particular region by dragging the mouse while
holding both mouse buttons down.

PC Link TCFl is intended to be an open system
and uses the Component One Chart 7.0 3D charting
control. The adventurous user can experiment with the
chart property pages by right clicking on the chart.
Almost any chart property can be changed. Click on
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the Help button for more information. If you corrupt the
chart, exit and restart PC Link TCFI.

Data Export and Import by Means of
Drag and Drop

You might want to export or import 3D table
data to or from another application such as Microsoft
Excel. Arrange the program windows so that both the
source and destination are visible (one on the left side
of the screen and the other on the right side seems to
work best). You must be able to see the information
you want to drag as well as the location where you
want to drop it. To export from PC Link TCFI to Excel,
use the left mouse button to select a range of data on
the spreadsheet grid. Then move the mouse cursor to
an edge around the selection. Hold the left mouse
button down and drag the selection into Excel. Release
the left mouse button on the top left cell in Excel. When
importing into PC Link TCFI from Excel, use the same
procedure, except that Excel requires dragging and
dropping with the right mouse button.

EDITING IGNITION ADVANCE TABLE
DATA

Once you have advance table data (by opening
an existing data file, downloading data from a TCFI unit
or creating a new table as explained in the previous
section), you can edit the data by clicking on and
dragging individual points on the 3D chart display or
you can directly edit numeric data on the spreadsheet
grid.

The table consists of 20 columns from zero to
7,500 RPM and 11 manifold pressure (MAP) rows from
10 to 30 In-Hg. The 7,500 RPM advance value is used

at all higher RPM levels and the 10 In-Hg MAP
advance value is used at all lower MAP levels. Note
that 10 In-Hg corresponds to a high vacuum
deceleration or idle condition and that 30 In-Hg
corresponds to wide open throttle (WOT). Advance
values must be between zero and 45 degrees.

You can shift the entire advance table up or
down by holding the Shift key down while dragging any
point. The chart label box shows the shift in degrees.
When you release the mouse button, the chart and
spreadsheet grid values will be updated. Response of
the chart label box may be sluggish on slower systems
due to the amount of data being updated.

After you have edited the table, you must use
the Save Table Edits To Buffer command from the Edit
menu to save your edits to buffer memory. If you use
the Close Table command from the Edit menu, all your
edits are lost.

Editing Table Data

You can edit table data using standard Windows
copy and paste operations by selecting cells and then
clicking the right mouse button to pop-up the edit
menu. You can select cells by dragging the mouse with
left button down. You can also use the Modify
command on the pop-up menu. When you enter a
value, the presence of optional sign (+ or -) or percent
(%) characters affects the outcome of the Modify
command as shown in Figure 8.

Chart Operations

You can rotate the 3D chart display for a better
view of a particular region by dragging the mouse while
holding both mouse buttons down.
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Figure 9 — Editing Advance Table Data
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PC Link TCFl is intended to be an open system
and uses the Component One Chart 7.0 3D charting
control. The adventurous user can experiment with the
chart property pages by right clicking on the chart.
Almost any chart property can be changed. Click on
the Help button for more information. If you corrupt the
chart, exit and restart PC Link TCFI.

Data Export and Import by Means of
Drag and Drop

You might want to export or import 3D table data
to or from another application such as Microsoft Excel.
Arrange the program windows so that both the source
and destination are visible (one on the left side of the
screen and the other on the right side seems to work
best). You must be able to see the information you
want to drag as well as the location where you want to
drop it. To export from PC Link TCFI to Excel, use the
left mouse button to select a range of data on the
spreadsheet grid. Then move the mouse cursor to an
edge around the selection. Hold the left mouse button
down and drag the selection into Excel. Release the
left mouse button on the top left cell in Excel. When

importing into PC Link TCFI from Excel, use the same
procedure, except that Excel requires dragging and
dropping with the right mouse button.

EDITING 3D TABLE DATA

In addition to the ignition advance table, there
are five other 3D tables that you can edit: AFR (air/fuel
ratio), Alpha-N (throttle position and RPM based fuel
table), front cylinder trim (percent fuel trim for front
cylinder), and front and rear BLM (block learn
multiplier). Before you can edit one of these tables you
must either open a data file or download data from a
TCFI unit. Due to the somewhat irregular shape of
these tables, editing data by clicking on and dragging
points on the chart is not feasible. You must edit the
numeric data on the spreadsheet grid.

Each table consists of 20 columns from zero to
7,500 RPM and 11 throttle position rows from 0% to
100%. The 7,500 RPM value is used at all higher RPM
levels.
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Figure 10 — BLM Table Showing Special Cells
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After you have edited a table, you must use the
Save Table Edits To Buffer command from the Edit
menu to save your edits to buffer memory. If you use
the Close Table command from the Edit menu, all your
edits are lost.

Alpha-N Table

The Alpha-N table is the main fuel table (Alpha-
N is the technical term for throttle position and RPM).
The Alpha-N table values are in percent units. The
calculated base injector pulse width (determined by
horsepower and injector size settings on the module
parameters screen) is multiplied by the Alpha-N table
value to determine the theoretical injector pulse width
for a 14.7 air fuel ratio. This value is then corrected for
the desired air/fuel ratio (as set on the AFR table) and
BLM (block learn multiplier) to arrive at the actual rear
injector pulse width.

From a practical standpoint, the Alpha-N table
must be within about +20% of the required values for
the TCFI system to successfully correct the injector

pulse width based on closed loop feedback from an
exhaust gas oxygen sensor.

AFR Table

The AFR (air/fuel ratio) table sets the desired
air/fuel ratio under various operating conditions. The
air/fuel ratio value is used in the rear injector pulse
width calculation as explained above. Typical air/fuel
ratios are 13.0 for idle, 13.8 for cruise, and 12.8 for
wide open throttle. To prevent engine overheating,
avoid lean air/fuel ratios exceeding 14.5 under cruise
conditions.

Front Cylinder Trim Table

The front cylinder trim table values are in
percent units. The calculated injector pulse width is
multiplied by the front cylinder trim value to arrive at
the front injector pulse width. Required front cylinder
trim values are dependent on engine gas flow
dynamics. The front cylinder trim table is automatically
corrected when the Apply Front BLM Table command
is executed. If you exceed the horsepower limits
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listed in Table 1 on page 9, front cylinder trim may
fail.

BLM Table

The rear BLM (block learn multiplier) table is
shown in the graphic above. BLM values are in percent
units and represent a correction factor required to
obtain the air/fuel ratio set on the AFR table. BLM
values are updated based on closed loop feedback
from the exhaust gas oxygen sensor.

Some special considerations apply to the BLM
tables. BLM values are limited in range from 75% to
125%. The range limits are set on the module
parameters screen. When a BLM cell nears the range
limit, the cell color changes to red to alert the user that
the system has just about run out of correction range
and that the corresponding cell in the Alpha-N fuel
table must be changed.

BLM cell values 0 and 1 command special
functions and these cells are highlighted in blue.
Closed loop feedback is disabled in any BLM cells with
value 0. This is useful in operating areas where
exhaust reversion effects may cause incorrect sensor
readings. Note that most BLM tables will have the
value 0 in cells corresponding to decel (RPM above
idle and closed throttle) where reversion effects are
most pronounced.

BLM update, but not closed loop feedback, is
disabled in any BLM cells with value 1. Some BLM
tables may have the value 1 in cells corresponding to
idle (1,000-1,250 RPM and closed throttle). Please
refer to the TCFI Idle Tuning Tech Note for more
information on this subject.

After several hours of engine operation, examine
the BLM (block learn multiplier) tables. If you see red
cells on a BLM table, you can use the corresponding
Apply BLM Table command (on the BLM Table
submenu) to automatically correct the Alpha-N fuel
table and front cylinder trim table. After running the
Apply BLM Table command, the BLM table cells will
return to 100%. Please remember to upload the data
back to the TCFI unit in order for the changes to take
effect.

The Reset BLM Table command on the BLM
Table submenu resets all BLM cells to 100%.

Editing Table Data

You can edit table data using standard Windows
copy and paste operations by selecting cells and then
clicking the right mouse button to pop-up the edit
menu. You can select cells by dragging the mouse with

left button down. You can also use the Modify
command on the pop-up menu. When you enter a
value, the presence of optional sign (+ or -) or percent
(%) characters affects the outcome of the Modify
command as shown in Figure 8.

Chart Operations

You can rotate the 3D chart display for a better
view of a particular region by dragging the mouse while
holding both mouse buttons down.

PC Link TCFl is intended to be an open system
and uses the Component One Chart 7.0 3D charting
control. The adventurous user can experiment with the
chart property pages by right clicking on the chart.
Almost any chart property can be changed. Click on
the Help button for more information. If you corrupt the
chart, exit and restart PC Link TCFI.

Data Export and Import by Means of
Drag and Drop

You might want to export or import 3D table data
to or from another application such as Microsoft Excel.
Arrange the program windows so that both the source
and destination are visible (one on the left side of the
screen and the other on the right side seems to work
best). You must be able to see the information you
want to drag as well as the location where you want to
drop it. To export from PC Link TCFI to Excel, use the
left mouse button to select a range of data on the
spreadsheet grid. Then move the mouse cursor to an
edge around the selection. Hold the left mouse button
down and drag the selection into Excel. Release the
left mouse button on the top left cell in Excel. When
importing into PC Link TCFI from Excel, use the same
procedure, except that Excel requires dragging and
dropping with the right mouse button.

EDITING 2D TABLE DATA

There are eleven 2D tables that you can edit.
Before you can edit one of these tables you must either
open a data file or download data from a TCFI unit.
Each table consists of 17 columns with the upper row
corresponding to the independent variable (throttle
position, engine temperature, elapsed time, or IAC (idle
air control) position. You can edit the numeric data
corresponding to the dependent variable on the lower
row of the spreadsheet grid. A typical 2D table is
shown below. Some of the engine temperature cells
are highlighted in red. These red cells correspond to
invalid sensor readings.
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After you have edited the table, you must use
the Save Table Edits To Buffer command from the Edit
menu to save your edits to buffer memory. If you use
the Close Table command from the Edit menu, all your
edits are lost.

TPS Transfer Function Table

This table determines the relationship between
TPS sensor volts and TPS percent used in various 3D
tables such as the Alpha-N table. Note that the table
starts at .39 volts, which is the nominal TPS sensor
output with the throttle closed at idle. Some aftermarket
throttle bodies, such as the S&S Cycle VFI Induction
System, do not use a standard Delphi throttle sensor
and thus require a different TPS transfer function. The
provided setup files have the proper TPS transfer
function and you should never change these
values unless given specific instructions from tech
support.

Delta TPS Fuel Multiplier Table

This table consists of a fuel multiplier (percent
units) that is a function of delta throttle position. Delta

throttle position means change in throttle position. Fuel
multipliers greater than 100% for positive delta throttle
position correspond to an acceleration enrichment
(similar effect to an accelerator pump on a carburetor).
Fuel multipliers less than 100% for a negative delta
throttle position correspond to a deceleration
enleanment (useful for reducing exhaust back fire).

IAC Based TPS Adder Table

This table consists of a throttle position factor
corresponding to IAC position. In an Alpha-N fuel
control, IAC position must be considered. A high IAC
position (high idle air flow) is the same as opening the
throttle. In general the values in this table need only be
edited if an aftermarket throttle body with significantly
greater air flow is used. In this case, the table values
should be reduced slightly.

Figure 11 — Typical 2D Table

ET Based Priming Fuel Table

This table consists of an injector pulse width that
is a function of engine temperature. The priming pulse
occurs once on the initial ignition switch on event.
Some of the engine temperature cells are highlighted
in red. These red cells correspond to invalid sensor
readings.

ET Based Cranking Fuel Table

This table consists of an injector pulse width that
is a function of engine temperature. The cranking pulse
width is used during engine start. Some of the engine
temperature cells are highlighted in red. These red
cells correspond to invalid sensor readings.

Time Based AFR Cold Start Enrichment
Table

This table consists of an AFR cold start
multiplier (percent units) that is a function of elapsed
time since engine start. This AFR cold start enrichment
is applied to the values in the 3D AFR table. The AFR
values are multiplied by the time based AFR cold start

ET [degC)| -1 i 16 0 32 | 48 | B4 | om0 | 8 | 112 12e | 144 | 160 EEENDEEEN DEEEN RN =R
Idle RPM | 1398 1320 1250 1172 1102 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 100
< >

enrichment and by the ET based AFR cold start
enrichment. For example, assume that the AFR value
in a given cell is 14.0 and that the time and ET based
AFR cold start enrichment values are 50% and 15%
respectively. The actual AFR value for that cell then
becomes 13.0 (14/(1 + 0.5 x 0.15)). The time based
AFR cold start enrichment should always taper off from
100% at zero elapsed time and must reach 0% at the
maximum value of elapsed time (251 seconds). In
general, the values in this table will be correct for most
applications and should not be changed without
consulting tech support.

ET Based AFR Cold Start Enrichment
Table

This table consists of an AFR cold start
multiplier (percent units) that is a function of engine
temperature. This table does double duty for hot soak
enrichment. Some of the engine temperature cells are
highlighted in red. These red cells correspond to invalid
sensor readings. In general, the values in this table will
be correct for most applications and should not be
changed without consulting tech support.
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Time Based Fuel Cold Start Enrichment
Table

This table consists of a fuel cold start multiplier
(percent units) that is a function of elapsed time since
engine start. The overall fuel cold start enrichment is
determined as follows: calculated injector pulse width
for each cylinder is multiplied by the time based fuel
cold start enrichment and by the appropriate ET based
front or rear cylinder cold start enrichment. The overall
fuel cold start enrichment is then added to the injector
pulse width. For example, assume that the calculated
injector pulse width is 4 msec and that the time and ET
based fuel cold start enrichment values are 50% and
25% respectively. The total injector pulse width is then
4.5 msec (0.5 x 0.25 x 4.0 + 4.0). The time based fuel
cold start enrichment should always taper off from
100% at zero elapsed time and must reach 0% at the
maximum value of elapsed time (251 seconds).

ET Based Front and Rear Cylinder Cold
Start Enrichment Table

These tables consist of a fuel cold start fuel
multiplier (percent units) that is a function of engine
temperature. Individual tables are used because most
engines exhibit significant differences in the
characteristics of the front and rear cylinders. These
tables also do double duty for hot soak enrichment.
Note that a significant enrichment is required at high
temperatures due to reduced injector flow. Some of the
engine temperature cells are highlighted in red. These
red cells correspond to invalid sensor readings. You
may need to edit these two tables for optimum cold
start and restart after hot soak. Please refer to the
TCFI Idle Tuning Tech Note. for more information
on this subject.

ET Based Idle RPM Table

This table consists of desired idle RPM as a
function of engine temperature. The ET based IAC
position (see table description below) is adjusted to
maintain the desired idle RPM. Some of the engine
temperature cells are highlighted in red. These red
cells correspond to invalid sensor readings.

ET Based IAC Position Table

This table consists of IAC (idle air control)
position as a function of engine temperature. Greater
IAC values result in more idle air and higher idle
speed. IAC position is continuously reduced as the
engine warms up, even if the engine is not idling.
Some of the engine temperature cells are highlighted

in red. These red cells correspond to invalid sensor
readings.

ET Based IAC Start Adder Table

This table consists of IAC (idle air control)
position as a function of engine temperature. The
values represent additional air flow through the idle
system during engine starting. Generally, more air is
required for a hot start, especially after a hot soak.
Some of the engine temperature cells are highlighted
in red. These red cells correspond to invalid sensor
readings.

Time Based IAC Start Adder Table

This table consists of a multiplier factor (percent
units) that is a function of elapsed time since engine
start. The multiplier factor is applied to the IAC start
adder in order to compensate for time dependent
characteristics of the throttle body after engine start,
especially after a hot soak. The table values should
always taper off from some initial value at zero elapsed
time and must reach 0% at the maximum value of
elapsed time (268 seconds). If the engine runs above
the desired idle RPM for several seconds when first
returning to idle after the motorcycle has been driven
some distance, a higher initial multiplier value is
required.

Editing Table Data

You can edit table data using standard Windows
copy and paste operations by selecting cells and then
clicking the right mouse button to pop-up the edit
menu. You can select cells by dragging the mouse with
left button down. You can also use the Modify
command on the pop-up menu. When you enter a
value, the presence of optional sign (+ or -) or percent
(%) characters affects the outcome of the Modify
command as shown in Figure 8.

Data Export and Import by Means of
Drag and Drop

You might want to export or import 2D table data
to or from another application such as Microsoft Excel.
Arrange the program windows so that both the source
and destination are visible (one on the left side of the
screen and the other on the right side seems to work
best). You must be able to see the information you
want to drag as well as the location where you want to
drop it. To export from PC Link TCFI to Excel, use the
left mouse button to select a range of data on the
spreadsheet grid. Then move the mouse cursor to an
edge around the selection. Hold the left mouse button
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down and drag the selection into Excel. Release the
left mouse button on the top left cell in Excel. When
importing into PC Link TCFI from Excel, use the same
procedure, except that Excel requires dragging and
dropping with the right mouse button.

MODULE PARAMETERS

Module parameters are divided into two
categories: basic parameters and advanced
parameters. Module parameters control the overall
operation of the TCFI unit. Setup and calibration of the
TCFI unit will generally involve editing some of the
basic parameters. Users should not modify any of the
advanced parameters without first consulting tech
support. Basic module parameters are displayed in a
dialog box by using the Edit Basic Module Parameters
command on the Edit menu.

Basic parameters include:

Closed Loop AFR Control Mode — allows BLM
(block learn multiplier) table updates based on
feedback from an exhaust gas oxygen sensor. Only
select this checkbox if the WEGO (wide-band exhaust
gas oxygen) unit is connected to the TCFI.

Dual Independent Runner Intake — you must
select this checkbox if you are using a dual
independent runner intake such as the BC Gerolamy
Dual Flow or S&S Cycle VFI Induction System. With a
standard Delphi intake system, the MAP sensor is
sampled as each cylinder approaches BDC on the
intake stroke. Dual independent runner intake systems
have the MAP sensor connected to the front runner.
When you select this checkbox, the MAP sensor is
only sampled when the front cylinder approaches BDC
on the intake stroke.

Continuous Barometric Pressure Update
Mode — recommended for operation in mountainous
terrain with elevation changes of more than 3000 feet.
Barometric pressure is continually estimated from
manifold pressure sampled at specific crank angle and
TPS conditions.

Enable Low Fuel Warning — you should select
this option for 2004 and later models equipped with a
speedometer that includes a low fuel warning LED.

When this option is selected, the TCFI also reports
engine temperature data for aftermarket speedometers
that support this feature.

Automatic Nominal Idle IAC Update Mode —
recommended for most applications. The nominal idle
IAC value (IAC steps once engine is fully warmed up
and at stable idle condition) is automatically sampled
and updated. Manual setting of the nominal idle IAC
value may be required for some applications. For more
information on this subject, please refer to the TCFI
Idle Tuning Tech Note.

Anti-Stall IAC Mode — for problem applications
where occasional engine stalling occurs when the
clutch is pulled in. In anti-stall IAC mode, closed loop
idle speed control is always active when engine RPM
is below the target idle RPM. This may cause an
unexpected increase in idle RPM if the engine is
inadvertently “lugged” down below the target idle RPM.
For more information on this subject, please refer to
the TCFI Idle Tuning Tech Note.

Estimated Wheel HP at 6000 RPM — enter a
reasonable estimate in order for the TCFI to calculate
the base injector pulse width. Well tuned engines will
develop about one horsepower per CID. If the
horsepower peak is below 6,000 RPM, use the peak
value. If the estimated value is too low, the engine will
initially run lean and this may interfere with auto-tuning.

Injector Size — flow rate in gm/sec units. Refer
to Table 4. You must enter the correct injector size
value in order for the TCFI to calculate the base
injector pulse width.

Table 4 — Injector Size

Model Injector Size (gm/sec)
2001-2005 Stock Twin 4.22
Cam 88®

2006 and later stock Twin | 3.91
Cam and Sportster®

Screamin Eagle® P/N 4.89
27654-06
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Figure 12 — Basic Module Parameters Dialog Box

W Edit Basic Module Parameters @

Basic Parameters
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[ Dual Independent Runner Intake

[ Continuous Barometric Pressure Update
| Enable Low Fuel Warning

I+ Automatic Nominal Idle IAC Update Mode
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Estimated Wheel HP at 6000 RPM a5
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Base Injector Pulse Width (msec)
RPM Limit (100 RPM steps) 5800

Cranking Rews (0-3)

N

Rear Cyl Timing Offset (-5 to +5)

i

VSS Frequency (Hz) at 100 KPH 1460
bth Gear Ratio (RPMIKPH) 23.5
WEGO Warmup Time [0-60 sec) 30

Idle TPS (1.0-2.5%) 0

19°

Nominal ldle IAC Steps (20-50) 30

User Data
‘200? Model 96 CID Setup

OK ‘ Cancel Restore Defaults

Base Injector Pulse Width — in millisecond
units. Please note the base injector pulse width is a
calculated value that you cannot directly edit.

RPM Limit — you can enter any value from
3,000 to 9,900 RPM. Values are automatically rounded
to the nearest 100 RPM.

Cranking Revs - sets the number of engine
revolutions before the ignitions fires the first spark.
Most engines will start best with a zero setting. Please
note that a hot engine may exhibit preignition and
appear to start on the first revolution even if the
Cranking Revs parameter is set to a non-zero value.

Rear Cylinder Timing Offset — you can set the
value over a -5 to +5 degree range. Leave the value at
zero if you do not require a rear cylinder timing offset.

VSS Frequency - this parameter sets the
correct speedometer and odometer scaling. An
incorrect value will also affect idle RPM control and
turn signal cancellation. Please refer to the following
section for more details.

6" Gear Ratio — applicable to 2007 and later
models only. This parameter sets the RPM/KPH ratio
used to detect the transmission gear and illuminate the
6t gear light. You can use the gear ratio display
function in TCFI Log software data logging chart
display to determine the required value for a particular
application. For 2001-2006 models, you can use the
default value of 23.5.

WEGO Warmup Time —in seconds. This
parameter determines the minimum engine run time
before closed loop AFR control.

Idle TPS — in percent units. This parameter
determines the maximum TPS (throttle position sensor)
value for closed loop idle speed control. The default
value is 1.0%. Some throttle bodies may require a
higher value for reliable idle speed control. For more
information on this subject, please refer to the TCFI
Idle Tuning Tech Note.

Nominal Idle IAC steps — this parameter
determines the nominal IAC (idle air control) stepper
motor position (value learned by system when engine
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is completely warmed up and at stable idle condition).
For more information on this subject, please refer to
the TCFI Idle Tuning Tech Note.

User Data — you can enter up to 32 characters
of user data that will be saved in EEPROM memory.
User data can contain comments or serial numbers.

Once you have entered the appropriate module
parameters, click on OK to save your edits to buffer
memory. If you click on Cancel, all your edits are lost.
You can click on Restore Defaults to restore default
values for a stock engine.

Advanced module parameters are displayed in a
dialog box by using the Edit Advanced Module
Parameters command on the Edit menu.

Advanced parameters include:

Warm Engine Temperature — in degree C
units. This parameter determines the minimum engine
(cylinder head) temperature before closed loop
corrections are saved to the BLM tables. The default
value is 95 degree C. Engine status changes from cold
to warm once the warm engine temperature is reached
and the engine warmup time has elapsed.

Engine Warmup Time — in seconds. This
parameter determines the minimum engine run time
before closed loop corrections are saved to the BLM
tables. The default value is 260 seconds. Engine status
changes from cold to warm once the warm engine
temperature is reached and the engine warmup time
has elapsed.

Hot Soak Temperature — in degree C units.
This parameter determines the minimum engine
(cylinder head) temperature before special hot soak
considerations apply when the engine is turned off.
The default value is 60 degree C.

Hot Soak Timeout — in seconds. This
parameter determines the minimum engine off time
(prior to a hot restart) before special hot soak
considerations apply. The default value is 60 seconds.

Delta TPS Gain — this parameter determines the
scaling of TPS values in the delta TPS based fuel
multiplier table. Do not change this parameter from the
default value of 5.

Enlean Decay Rate — this parameter
determines the time constant of recovery from
enleanment (negative delta TPS values) in the delta
TPS based fuel multiplier table. Do not change this
parameter from the default value of 25.

Enrich Decay Rate — this parameter determines
the time constant of recovery from enrichment (positive
delta TPS values) in the delta TPS based fuel multiplier
table. Do not change this parameter from the default
value of 20.

Minimum Injector Pulse Width — in millisecond
units. This parameter affects linearity of the fuel tables
at low values. Do not change this parameter from the
default value of 0.1.

Idle Integrator Gain — this parameter
determines the response time of closed loop idle speed
control. A higher value will result in a faster response
but may cause instability (oscillation). The default value
is 10.

AFR Integrator Gain — this parameter
determines the response time of closed loop AFR
control. A higher value will result in a faster response
but may cause instability (oscillation). The default value
is 30.

AFR Deadband — in AFR units. This parameter
determines the deadband (minimum error before
system response) for closed loop AFR control. A small
deadband value improves closed loop stability and
reduces hunting. The default value is 0.3.

Min AFR BLM —in percent. This parameter
limits the minimum BLM value when the system is
correcting a rich condition. The default value is 75%.

Max AFR BLM — in percent. This parameter
limits the maximum BLM value when the system is
correcting a lean condition. The default value is 125%.

Asynchronous Fuel Gain — this parameter
determines the amount of fuel that is immediately
(asynchronously) injected when the throttle is rapidly
opened. Higher values result in more fuel. A zero value
disables asynchronous injection.
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Figure 13 — Advanced Module Parameters Dialog Box
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VIN ENTRY

Use the Edit TCFI VIN command to program the
VIN. This function is optional and only supported by
TCFI Gen 4 Rev 2.0 and later units.

If the TCFI firmware is updated using Mega Boot
Programmer software, the VIN must be reentered.
Note that the VIN is not stored as part of a VRFI setup
file and is not changed if a different setup file is
uploaded.

SPEEDOMETER CALIBRATION

For 2001-2003 models, the VSS scaling affects
data displayed by TCFI Log and idle speed control.
You must enter the value shown in Table 5 (used for all
models). For 2004 and later models with the instrument
cluster on the SAE J1850 data bus, the VSS frequency
parameter sets the correct speedometer and odometer
scaling. You can find the exact value in the
speedometer section of the factory service manual for
your model. Use the frequency value at 100 KPH.
Values for most 2004-2006 models are given in Table
6. Preliminary values for 2007 and later models are
given in Table 7. For models not listed, you can use
TCFI Log software to examine data logged while the
motorcycle was operated at a known speed in 6! gear.
Use the speedometer recalibration procedure as
explained below to recalculate the VSS frequency. Use
the gear ratio display function and average several
readings to determine the 6" gear ratio.

Table 5 — VSS Frequency at 100 KPH for

2001-2003 Models

Model

All 2001-2003

155 Hz

Table 6 — VSS Frequency at 100 KPH for

2004-2006 Models

Model All exc. Japan
Japan Only
Sportster 883 1431 Hz 1635 Hz
Sportster 1200 1386 Hz 1526 Hz
Dyna (exc. 1424 Hz 1583 Hz
FXDP)
Dyna FXDP 1435 Hz N/A
Softail (exc. 1403 Hz 1501 Hz
FXSTD)
Softail FXSTD 1382 Hz 1506 Hz
Touring Models | 1375 Hz 1493 Hz
(exc. Police)
Touring Models | 1435 Hz 1435 Hz
(Police)
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Table 7 — VSS Frequency and 6™" Gear
Ratio for 2007 and Later Models

Model VSS Frequency | 6" Gear Ratio
at 100 KPH (RPM/KPH)

Softail 1460 Hz 235

Sportster | 1386 Hz 235

Speedometer Recalibration (for 2004 and
later models only). You can easily recalibrate the
speedometer (and odometer) to accommodate tire and
gear changes. Run the motorcycle on a chassis dyno
at a constant speed. Note the speedometer reading
and the correct speed indicated on the dyno. Use the
following formula to calculate the new VSS frequency
parameter:

New VSS Freq = Original VSS Freq x Speedo Reading
Indicated Dyno Speed

For example, if the original VSS frequency
parameter was 1403 Hz, the speedometer reading is
60 MPH and the indicated dyno speed is 57 MPH, then
the new VSS frequency parameter should be:

1476 Hz = 1403 Hz x 60 MPH
57 MPH

The speed units cancel out, so you can use
either MPH or KPH units in the calculation as long as
you use the same units for both the speedometer
reading and dyno speed. For best accuracy, use a test
speed near highway cruising speed.

USER FUNCTIONS

User functions are displayed in a dialog box by
using the Edit User Functions command on the Edit
menu. User functions control the operation of the user
input and user output of the TCFI unit.

The user input on pin 16 is a 0 to +5V input that
is internally "pulled high" to +5V. The input pin is
sampled and the data is always logged as part of the
TCFI data logging function. The user input can also be
used for other functions such as selecting a stage RPM
limit. In this case the user input is “active low” with a
threshold of about 2.5V. You can connect a switch
between the user input and ground. When the switch is
closed and the user input pin is grounded, the stage
RPM limit (our other selected function) will be
activated.

The user output on pin 22 can drive a small load
up to 0.5 amps and is protected against short circuits.
The user output is “active low.” It can be used to drive
a standard automotive relay returned to +12V. When
the user output is active, the pin is grounded.

User input functions include:

Data Log Only — default mode. For data logging
connected switches.

Ignition Retard — applies user retard value (0 to
10 degrees) whenever the user input is grounded. To
avoid potential conflicts, do not select ignition retard
mode if the user output is in NOS trigger mode.

Ignition Kill — disables spark firing whenever
the user input is grounded. Can be used with an air
shifter to reduce stress during shifts.

Stage RPM Limit — activates stage RPM limit
(2000 to 9900 RPM) whenever the user input is
grounded.

User output functions include:
Off — default mode.

RPM And TPS Based Switch — general
purpose switch function based on RPM and TPS. The
user output is set on (pulled to ground) when RPM >=
RPM On AND TPS >= TPS On. The user output then
remains on until it is reset off when RPM > RPM Off
OR TPS < TPS Off. This feature allows you to
implement an RPM and TPS based window switch. In
the sample data above, the use output would be active
between 3000 and 5000 RPM if the throttle was
opened above 90%.

NOS Trigger — specifically designed to trigger
an NOS system. The user output is set on (pulled to
ground) when RPM >= RPM On AND TPS >= TPS On
AND VSS >= Minimum VSS. The user output then
remains on until it is reset off when RPM > RPM Off
OR TPS < TPS Off OR VSS < Minimum VSS. As an
additional safety feature to prevent engine damage, the
user output is immediately tripped off if the RPM limit is
exceeded and cannot be set back on again until the
TPS drops below the TPS Off level. In NOS trigger
mode, the user retard value (0 to 10 degrees) is
applied whenever the user output is on.

Individual parameters are enabled or disabled
(grayed out) based on the user functions you selected.
Once you have entered the appropriate user function
parameters, click on OK to save your edits to buffer
memory. If you click on Cancel, all your edits are lost.
You can click on Restore Defaults to restore default
values.
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Figure 14 — User Functions Dialog Box
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UNITS SELECTION

You can select the temperature, pressure, and
air/fuel ratio units used for table data display. Use the
Units Selection command on the Edit menu. A dialog
box will appear as below. You can select Fahrenheit
(F) or Celsius (C) temperature units, inches of mercury
(In-Hg) or kilopascals (kPa) manifold pressure units,
and air/fuel ratio in gasoline AFR or Lambda units. The
program remembers the selections you have made.

Figure 15 — Units Selection Dialog Box

W Units Selection

AirfFuel Ratio (AFR)
@ Gasoline AFR

Temperature Pressure
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ok |
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UPLOADING DATA

Refer to the Downloading Data section on page
19 for details about USB interface hookup and COM
port setup. Before uploading, make sure the module
parameters are correct.

Upload data by using the Upload Data To TCFI
command on the Communications menu. A status
message is displayed when the upload process has
been successfully completed.

If you attempt to upload data to anything
other than a TCFI unit with correct firmware, an
error message will appear and the upload will be
aborted.

TROUBLESHOOTING FLOWCHART

Follow the troubleshooting flowchart shown on
the following page. Experience has shown that most
communication problems are user error or PC
compatibility issues.
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Software Communications Troubleshooting Flowchart

STARTING
POINT

IS RS-232 TIMEOUT ERROR MESSAGE
DISPLAYED WHEN ATTEMPTING
DOWNLOAD OR UPLOAD?

YES NO |

FOR MISC PROBLEMS,
CALL TECH SUPPORT.

GYCLE ENGINE RUN/STOP SWITCH.
VERIFY CHECK ENGINE LIGHT
ILLUMINATED. IS PROBLEM FIXED?

YES I NO

DONE

USE WINDOWS DEVICE MANAGER TO
VERIFY THAT CORRECT COM PORT IS
SELECTED. IS PROBLEM FIXED?

YES I NO |
CALL TECH SUPPORT

DONE
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TCFI LOG SOFTWARE OVERVIEW

TCFI Log software runs under Microsoft
Windows XP/Vista/7/8. Version 15 of the TCFI Log
software supports all TCFI IIl (Gen 3) and TCFI Gen 4
fuel injection controllers. The software allows users to
view real time engine data during dyno tuning,
download and display data logged by the unit including
operating statistics, and to control certain engine
functions. The term TCFl is used throughout this
document as a generic term and refers to the new
TCFI Gen 4 version unless otherwise noted.

After TCFI Log is launched, the main screen
appears blank. You have multiple display options. You
can display real time engine data on an instrument
panel type screen by using the View Real Time Data
command on the View menu. You can display and print
data logged by the TCFI unit on a chart recorder type
screen. Data logged by the TCFI unit must be
downloaded before it can be displayed, by using the
Download Logged Data From TCFI command on the
Communications menu. Once data has been
downloaded, it is automatically displayed on a chart
recorder type screen. You can save this data by using
the Save File command from the File menu. You can
display a previously saved data file by first using the
Open File command on the File menu and then using
the View Chart command on the View menu.

You can also download, view, and print engine
operating statistics and historical diagnostic codes by
using the Download Statistics and Diagnostic Codes
command from the Communications menu. Please
note that this data is not saved.

TCFI Log Version 15 is only compatible with
TCFI Gen 3 or Gen 4 units and cannot be used to
download data or open files from earlier TCFI units.

A sample data file (Sample.log) is included in
the program folder.

SOFTWARE INSTALLATION

The software is in the form of a compressed file
downloaded from our website. The installation process
uses InstallShield. This industry standard installer is
based the new Microsoft Windows Installer service that
greatly reduces potential problems such as version
conflicts and allows for application self-repair. Before
proceeding with installation, shutdown any other
applications that may be running. For Windows Vista,
you must disable the User Account Control (UAC)
during installation. If you are not familiar with the UAC,
please refer to the Vista UAC Tech Note on our
website's Tech FAQ for details.

Use the Windows Explorer to launch the
TCFI_Log setup.exe file downloaded from our website.
InstallShield will install the software in an appropriate
folder under Program Files.

Once InstallShield has completed the
installation, TCFI Log will appear on the Windows Start
Menu. You can then launch it just as you would any
other Windows program.

TCFI Log requires the Monospace 821 BT fixed
pitch printer font in order to properly align columns
when printing. The Monospace 821 BT font is included
in the distribution media and automatically copied to
your Windows Fonts folder during installation. A
backup copy is also placed in the program folder. If you
accidentally delete this font, use the Install New Font
command from the Fonts folder File menu. The
filename associated with Monospace 821 BT is
monos.ttf.

TCFI CONNECTION

The USB interface, P/N 102004, is used for
communication with the TCFI module. No additional
hardware is required. The USB interface connects to
the four terminal Deutsch data link connector that is
part of the WEGO harness (refer to Figure 27 for
details). The USB Interface has a switch that selects
the operating mode. For communication with the TCFI,
you must use the TC88A And All Others switch
position

Turn the ignition key and engine run/stop
switches on to provide power to the TCFI unit. Do not
start the engine.

If the TCFI unit has been removed from the
motorcycle, you can do bench top programming by
using an adapter harness (P/N TCFI-ADAPT) that
includes a small 12 volt DC power supply.

The TCFI Log program has auto-connect
capability and a COM port scan function to aid in initial
setup of the communications link. You can use the Port
Setup command from the Communications menu to
display the dialog box shown below and select the
correct COM port.

If you are not sure what COM port the USB
interface has been assigned to, you can click on the
Scan button to automatically detect and select the
correct port. Before you do so, make sure that the USB
interface has been connected to your PC and the TCFI
module. Both the ignition key and engine run/stop
switches must be turned on. Once the correct COM
port has been selected, the program will remember this
setting.
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If you enable the Auto Connect check box, the
program will try to connect to the TCFI every time the
program is started. Please note that you must have the
correct COM port selected and the USB interface
connected to your PC and the TCFI module. Both the
ignition key and engine run/stop switches must be
turned on in order for auto-connect to work properly.

Figure 16 — Data Port Setup

Data Port Setup

Port Com1 ~

[ Auto Connect

Scan ‘

REAL TIME ENGINE DATA DISPLAY

When the engine is running, you can display real
time engine data on an instrument panel type screen
by using the View Real Time Data command on the
View menu. Please note that real time engine data
cannot be directly saved by means of the TCFI Log
program. However, this data is constantly being logged
by the TCFI unit and can be downloaded (for example
at the end of series of dyno runs).

Real time engine data is displayed on an
instrument panel type layout with round tach and
speedometer gauges and bar graph type gauges for
most other parameters. Barometric pressure, any
diagnostic codes, status of the user input and output,
and status messages are displayed in additional
windows. If the engine is not running most values will
appear as zero.

Displayed parameters include:

RPM - engine crankshaft RPM (numeric value
displayed beneath gauge)

VSS - vehicle speed in MPH or KPH (numeric
value displayed beneath gauge)

TPS — throttle position (0 to 100%)

MAP — manifold pressure in In-Hg (29.92 In-Hg
or 101.3 kPa corresponds to atmospheric
pressure)

ET — engine cylinder head temperature

IAT — intake air temperature

BAT — battery voltage

IAC — idle air control stepper motor position
(higher number means more idle air)

AFR — the air/fuel ratio bar graph has dual
pointers. The yellow pointer on the left side is
the air/fuel ratio command (from AFR table). The
white pointer on the right side is the actual
air/fuel ratio based on the exhaust gas oxygen
sensor reading. Note that the value will remain
near 10 until the sensor has warmed up. Front
and rear cylinder AFR values are displayed for
all TCFI Gen 4 units when the WEGO IIID is
installed.

BLM — block learn multiplier (main fuel table
correction factor based on exhaust gas oxygen
sensor feedback, shown as percent value from
75-125%). Separate front and rear cylinder BLM
values are displayed.

FRONT INJ, REAR INJ - injector pulse width in
milliseconds or duty cycle in percent

FRONT ADV, REAR ADV - ignition advance in
degrees BTDC

You can also select the vehicle speed,
temperature, pressure, and injector data units
used for real time engine data display and data
logging chart display. Use the Units Selection
command on the Edit menu. A dialog box will
appear as shown below. You can select miles
per hour (MPH) or kilometers per hour (KPH)
vehicle speed units, Fahrenheit (F) or Celsius
(C) temperature units, inches of mercury (In-Hg)
or kilopascals (kPa) manifold pressure units,
pulse width in milliseconds or duty cycle in
percent for injector data, and air/fuel ratio in
gasoline AFR or Lambda units. The program
remembers the selections you have made.

Figure 17 — Units Selection

W Units Selection E@
Speed Pressure AirfFuel Ratio (AFR)
® MPH ® In-Hg @® Gasoline AFR
T KPH " kPa ¢ Lambda
Temperature Injector Data
" Fahrenheit @ Pulse Width (msec) oK
@® Celsius " Duty Cycle (%)
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Figure 18 — Real Time Engine Data Display
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IDLE TPS DISPLAY

You can check the idle TPS adjustment by using
the View Idle TPS command on the View menu. Turn
the run/stop switch on, but do not start the engine
when using this function. Idle TPS volts are displayed
on the TPS bar graph gauge. All other instrument
values will appear as zero.

With the throttle fully closed, verify that the
gauge display is between .30 to .80 volts. If the value is
outside this range, you will have to adjust the TPS
sensor. For optimum performance, adjust the TPS
sensor to .40 volts.

BARO (IN-HG)
DIAG CODE

P0123 Idle TPS High

USERIN USER OUT
OFF
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IAC MANUAL OVERRIDE

The IAC Manual Override command on the
Communications menu allows you to manually override
the idle air control stepper motor position while the
engine is running and vehicle speed is zero. Once the
vehicle is moving, normal closed loop idle speed
control always resumes. This command is primarily
used to calibrate larger aftermarket throttle bodies, but
can also be used as a diagnostic aid.

USER OUTPUT MANUAL OVERRIDE

The User Output Manual Override command on
the Communications menu allows you to manually
override the user output on TCFI units. This command
can be used as a diagnostic aid to test accessory
systems connected to the user output.
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DATA LOGGING CHART DISPLAY

You can also display data logged by the TCFI
unit on a chart recorder type screen. The data logging
memory within the TCFI stores the last 36000 data
points at 10 samples/second. This corresponds to 60
minutes of data. When you use the Download Logged
Data From TCFI command on the Communications
menu, the popup menu shown in Figure 19 will appear.
You can select the length of the data set that will be
downloaded. Once data has been downloaded, it is
automatically displayed. The last data logged will
appear at the right end of the chart. You can save
the data by using the Save File command from the File
menu after closing the chart display (data is not lost by
closing the chart display). You can display a previously
saved data file by first using the Open File command
on the File menu and then using the View Chart
command on the View menu.

Figure 19 — Download Options

w Download Options Eg
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Please note that real time engine data cannot be
directly saved by means of the TCFI Log program.
However, this data is constantly being logged by TCFI
unit and can be downloaded (for example at the end of
series of dyno runs).

Note that TCFI data files use a .log extension.
You should create a separate folder to store these
files.

You can select two parameters for display.
Trace 1 is displayed in red with its Y axis legends on
the left side of the chart. Trace 2 is displayed in green
with its Y axis legends on the right side of the chart.
The X axis is always elapsed time. You can zoom in,
zoom out, or zoom all (displays entire data file). At the
maximum zoom in level, approximately 100 data
samples will be displayed on the chart. You can use
the scroll bar to move the chart display window in
terms of elapsed time. If you hold the left mouse button
down within the chart area, a cursor line appears. The
exact values of the parameters displayed on trace 1

and trace 2 and the elapsed time appear in windows
above the chart. When you zoom in or zoom out, the
displayed data will always be centered about the
cursor line. This allows you to quickly select and
closely examine an area of interest. If you want to
analyze the elapsed time between two events (for
example the time required to accelerate from O to 60
MPH), you can move the cursor to the first event and
then click on the Reset Time Display button. You can
print the displayed chart to any Windows printer by
clicking on the Print button (a color inkjet printer is
recommended for best results).

Data parameters include:
RPM - engine crankshaft RPM

VSS — vehicle speed in MPH or KPH

MAP — manifold pressure in In-Hg (29.92 In-Hg
or 101.3 kPa corresponds to atmospheric
pressure)

TPS - throttle position (0 to 100%)

AFR CMD - air/fuel ratio command (10:1 to
20:1). This is the AFR value the TCFl is
attempting to maintain.

FRONT AFR, REAR AFR — air/fuel ratio based
on the exhaust gas oxygen sensor reading (10:1
to 20:1).Front and rear cylinder AFR values are
displayed for all TCFI Gen 4 units when the
WEGO IIID is installed.

FRONT BLM, REAR BLM - block learn
multiplier (main fuel table correction factor based
on exhaust gas oxygen sensor feedback, shown
as percent value from 75-125%). Separate front
and rear cylinder BLM values are displayed.

IAC — idle air control stepper motor position
(higher number means more idle air)

IAT — intake air temperature
ET — engine cylinder head temperature

FRONT INJ, REAR INJ - injector pulse width in
milliseconds or duty cycle in percent

FRONT ADV, REAR ADV - ignition advance in
degrees BTDC

BAT — battery voltage

USER IN — user input displayed as digital
(on/off) signal. On means that the input is active
(grounded).
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USER OUT - user output displayed as digital
(on/off) signal. On means that the output is

grounded.

Additional data is displayed at the lower right
side of the screen. This data includes:

Diagnostic Code — normally blank unless a
diagnostic code is set. Refer to page 14 for

details.

Edit

Engine Status — based on engine temperature
and open/closed loop AFR

Log Interval — the actual data logging interval in
seconds

You can clear the data within the TCFI by using

the Clear TCFI Data Buffer command from the
Communications menu.

Figure 20 — Data Logging Chart Display
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The following additional functions are available
from the Edit menu:

Fuel Cell Display — shows the active cell in
terms of RPM and TPS percent at the cursor
position. TPS percent is compensated for idle
air. This function is useful for determining what
fuel table cell is active at any given point in time.
The same RPM and TPS cell is active in all fuel

tables.

Gear Ratio Display — shows the calculated gear
ratio (RPM/KPH) at the cursor position. This
function is useful for determining the 6th gear
ratio required for Module Parameter setup in PC
Link TCFI for 2007 and later models with six
speed transmissions and 6th gear indicator.

Misc Data Display — shows the current
barometric pressure and nominal IAC value
(value learned by system when engine is
completely warmed up and at stable idle
condition).
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OPERATING STATISTICS

You can also display engine operating statistics
logged by the TCFI unit. Data logged by the TCFI unit
must be downloaded before it can be displayed, by
using the Download Statistics and Diagnostic Codes
command on the Communications menu. Once data
has been downloaded, it will automatically be
displayed. If you exit from the display, you can view the
same data again by using the View Statistics command
from the View menu. Please note that this data is not
saved.

The data is fairly self-explanatory. Total hours
represents the total time that the engine was running.
ID represents the firmware identification. This field
typically includes the manufacturer (Twin Tec), model
number, program revision and author's initials, and

date. Note that the date is not a manufacturing date
code, just the date for the particular firmware release.

Elapsed time is displayed for 13 RPM bands
from idle to 6999 RPM. Note that elapsed time data is
rounded off during each engine run, so the sum of the
elapsed time figures may not precisely match the total
hours. The program also displays the maximum engine
RPM, time at the RPM limit (in seconds for better
resolution) and the number of engine starts.

Clicking on the Print Statistics button prints a
report. When you click on this button, a small data
entry screen pops up and allows you to add a serial
number or comment that will appear on the printout.
You can also use the Print command from the File
menu.

Figure 21 - Operating Statistics Display

m Twin Tec TCFl Data Logging Program - Operating Statistics

TCFI Operating Data

Print Statistics
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Figure 22 - Operating Statistics Histogram Chart
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Any historical diagnostic codes logged by the
TCFI unit are listed along with the number of trips
(engine start cycles) since the individual code was last
logged. Codes are automatically cleared after 50 trips.

Customers are often confused about the
meaning of the term “trips.” This is an industry
standard terminology. If a code shows 40 trips, it
means that the code was set 40 engine start cycles
ago, not that the code has been set 40 times.

Refer to the page 14 for further information
about diagnostic codes. You can clear historical
diagnostic codes by using the Clear Historical
Diagnostic Codes command from the Communications
menu.

The elapsed time data in the various RPM
bands can be displayed in the form of a histogram
chart by clicking on the Histogram button. Color coding
of the bars helps to interpret the data. The idle RPM
band is blue, normal operating RPM bands are green
and high RPM bands are yellow and red. The chart is
automatically scaled for best display. You can print the
chart along with a complete statistics report by clicking
on the Print Chart button.

IMPORTING DATA INTO EXCEL

Data files saved from TCFI Log are in comma
delimited ASCII format. You can easily import a data
file into other programs such as Microsoft Excel for
further analysis. You can also view data files with a text
editor such as Windows WordPad. To import a data file
into Excel:

1. Start Excel. In the File Open dialog box, select
Files of type: All Files (*.*). Then browse for the
data file.

2. The Text Import Wizard appears. For step 1, select
delimited file type. For step 2, select comma
delimiter. For step 3, select general column data
format. Then click on Finish.

3. You can then format the data and save the
spreadsheet as an Excel file.

TROUBLESHOOTING FLOWCHART

Follow the troubleshooting flowchart shown on
page 33. Experience has shown that most
communication problems are user error or PC
compatibility issues.
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TCFI GEN 4 PRE-INSTALLATION
CHECKS

Make sure that the OE Delphi® system is
functioning correctly (other than tuning issues) before
attempting TCFI installation. If the OE Delphi® system
is setting diagnostic codes, find and correct any
underlying problems first.

Correct operation of the throttle position sensor
(TPS) is critical for proper operation of the TCFI
system. The TPS has a resistance element similar to
the volume control on a radio. In time, it will wear out
and become noisy. We recommend replacing the TPS
after 10,000 miles.

TCFI GEN 4 INSTALLATION

1. If motorcycle is equipped with security system
(TSSM module), make sure system is disarmed.
Turn off the ignition switch and disconnect the
battery ground cable before proceeding.

2. Find and remove the Delphi® module. The OE
module is usually located under the seat or under
a side cover.

3. Install the TCFI module. Figures 23 and 24 show
typical installations. Most applications can reuse
the original mounting hardware. Some models use
a mounting bracket with #10-32 studs. The TCFI
housing has insufficient clearance to accommodate
the OE nuts with captive lock washers. #10-32
small pattern nuts, washers, and lock washers are
included in the TCFI parts bag for this purpose.

On some Dyna™ models, the electrical caddy
must be modified to provide clearance for the
TCFI. Use a die grinder or Dremel motor tool to
remove interfering plastic ribs.

4. Sportster® applications only. Refer to Figure 25.
The parts bag includes a yellow ion-sense jumper
wire with a small female Delphi® Micro-Pack
terminal on one end. Install this terminal in pin 27
of the Delphi connector that mates with the TCFI
module. The other end is routed to the ignition coil.
Cut the yellow/green wire going to pin B on the coll
connector. Solder the yellow ion-sense wire to the
end of the yellow/green wire going to pin B on the
coil. Make sure pin A is still connected to the
system relay.

5. Do not reconnect the battery ground cable until
you have completed installation of the WEGO
IIID. Do not attempt to start the engine until
you have completed the initial setup.

Figure 23 - Typical Twin-Cam Installation with
WEGO 111D Mounted on Top of TCFI Unit
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Figure 24 - Typical Sportster® Installation with
WEGO 111D Mounted to Side of Battery

Figure 25 - Sportster® lon-Sense Wiring
Modification at Ignition Coil
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GENERAL RECOMMENDATIONS

The TCFI is designed to be used with the H-D®
OE coil. Fuel injected engines require a special coil
with low primary resistance and an additional terminal
for ion-sensing. Do not attempt to use any aftermarket
coil.

Due to the short lengths involved on motorcycle
applications, energy losses in spark plug wires are
insignificant. OE carbon core suppression cables will
deteriorate after several years. For a more durable
replacement, we suggest spiral core type spark plug
cables.

CAUTION: Do not use solid copper
spark plug cables or non-resistor type
spark plugs. The TCFI unit may misfire.

WEGO IIID INSTALLATION
OVERVIEW

When used with the Twin Tec TCFI Gen 4, the
dual channel WEGO IIID allows simultaneous front and
rear cylinder fuel auto-tuning during actual riding
conditions. The terms TCFl and WEGO are used
throughout this document as generic terms and
refer to the various TCFI Gen 4 and WEGO IIID
units unless otherwise noted.

The WEGO system uses low cost Bosch LSU
4.2 5-wire wide-band oxygen sensors. By utilizing
miniature surface mount electronics technology, digital
signal processing techniques, and a switching power
supply for the sensor heater, the WEGO provides the
same level of accuracy as lab systems costing
thousands of dollars.

The WEGO unit has dual 0-5 volt analog air/fuel
ratio (AFR) outputs that are connected to the TCFI for
closed loop AFR control.

REPLACEMENT SENSORS AND
ACCESSORIES

The WEGO uses standard Bosch LSU 4.2
sensors used on a VW production application (Bosch

P/N 0 258 007 057/058 or VW P/N 021 906 262B). The

proprietary VW connector is replaced with a smaller
Deutsch DT-04-6P. We offer replacement sensors with
the Deutsch connector installed.

WEGO IIID INSTALLATION

1. Turn off the ignition switch before proceeding.

In general, the sensors should be mounted 2-8
inches from the head flange. Available clearance
will usually dictate the optimum location. When
choosing a mounting location, allow several inches
clearance for the sensor wire harness. The wire
harness must exit straight out from the sensor. Do
not loop the harness back onto the sensor body.

2006 and later models with original equipment
18 mm oxygen sensors (all others skip ahead
to step 4). You can use the original equipment
(OE) oxygen sensor mounting bosses. Remove the
OE sensors. You do not have to remove any of the
OE wiring, just tape up the mating connectors. Do
not install the new Bosch sensors until after the
free air calibration procedure described in the
following section. Always use an anti-seize
lubricant such as Permatex 133A on the sensor
threads. Softail® models may require removal of
the seat post/coil bracket for clearance during
installation of the rear sensor. Skip ahead to step
5.

18 x 1.5 mm weld nuts must be welded onto the
exhaust pipes. After welding, run an 18 x 1.5 mm
tap through the threads. Failure to clean the
threads may result in sensor damage. Note that
most automotive muffler shops are familiar with
oxygen sensor weld nut installation on custom
pipes. Do not install the sensors until after the free
air calibration procedure described in the following
section. Always use an anti-seize lubricant such as
Permatex 133A on the sensor threads.

Figure 26 — Typical Sensor Installation

Install the WEGO unit. For most applications, the
WEGO can be mounted on top of the TCFI Gen 4

Daytona Twin Tec LLC, 240 Springview Commerce Drive - BLD 1-J Debary, FL 32713

(386) 304-0700 www.daytona-twintec.com

Page 42

TCFI 4 Manual Rev 3.2
8/2021


http://www.daytona-twintec.com/

unit using #6-32 socket head cap screws and
washers provide in the parts bag.

6. Connect the Bosch sensors to the 6 pin mating
connectors on the WEGO wire harness. The longer
cable (with yellow band) is for sensor 1 (front). For
additional protection and improved cosmetics, use
Techflex 1-1/4” Black Flexo Clean Cut FR
expandable sleeving over the connectors
(available from www.wirecare.com).

7. Refer to Figure 27. Connect the WEGO power
cable to the four terminal Deutsch style data link
connector on the H-D® wiring harness. In most
cases, the data link connector is near the ECM
(engine control module). Refer to the H-D®

Electrical Diagnostic Manual for your model for
connector location. Some models may have similar
appearing connectors that could be mistaken for
the correct data link connector.

8. Connect the green, blue and white wires from the
WEGO to the TCFI as shown in Figure 27. The
female Micro-Pack terminals at the end of these
wires are installed in the OE Delphi connector that
mates with the TCFI. Carefully open the Delphi
strain relief and remove the clear plastic retainer.
Pull out the blue seals at pins 8, 9 and 23.
Remove and tape up any existing wires at
these pins. Install the female Micro-Pack
terminals. Pin numbers are marked on the strain
relief.

Figure 27 - WEGO Hookup
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WEGO IIID OPERATION

For more information about wide-band oxygen
sensors including the Bosch LSU 4.2, we suggest that
you visit the Tech FAQ on our website at
www.daytona-sensors.com.

The WEGO has red status LEDs for each
channel. When power is turned on, the LEDs blink at a
slow rate until the corresponding sensor has reached
normal operating temperature.

After installation, the WEGO system requires
free air calibration. This should be done with the
sensors dangling in free air. The environment must be
free of hydrocarbon vapors. We suggest that you
perform the free air calibration outdoors. Turn the free
air calibration trimpots on the WEGO full

counterclockwise. Turn on power and wait for 60
seconds so the system can fully stabilize. Then slowly
turn each free air calibration trimpot clockwise until the
corresponding LED starts flashing at a rapid rate. Try
to set each trimpot at the point where its LED just
starts to flash.

The free air calibration procedure should be
performed at reasonable intervals (every 250-500
hours) or whenever a sensor is replaced. If you cannot
get an LED to rapidly flash when its trimpot is turned
full clockwise, you either have a damaged sensor or
very high hydrocarbon levels in your environment.

If both LEDs keep blinking at the slow rate, you
may have a low battery voltage condition. Try
connecting a battery charger.
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Figure 28 - WEGO Unit
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The WEGO includes internal diagnostics for
abnormal battery voltage (less than 11 volts or greater
than 16.5 volts), sensor open circuit, and sensor short
circuit conditions. A fault condition causes the status
LEDs to blink at the slow rate.

CAUTION: Racing gasoline containing
lead will quickly degrade the sensors.
Under these conditions, expected
sensor life is less than 10 hours. There
iS no warranty on sensors.

TROUBLESHOOTING FLOWCHART

Follow the troubleshooting flowchart shown
below. Experience has shown that most units returned
for warranty are OK and another problem, such as user
error, a degraded sensor, or bad power connections is
later identified.

Daytona Twin Tec LLC, 240 Springview Commerce Drive - BLD 1-J Debary, FL 32713

(386) 304-0700 www.daytona-twintec.com

TCFI 4 Manual Rev 3.2
8/2021

Page 44


http://www.daytona-twintec.com/

WEGO 111D Troubleshooting Flowchart

STARTING
POINT

NOTE: ALL TESTS PERFORMED
WITH SENSORS IN FREE AIR

DO STATUS LEDS SLOWLY BLINK WHEN
POWER IS FIRST TURNED ON?

NO I

YES

VERIFY +12V POWER ON RED WIRE.
VERIFY BLACK WIRES CONNECTED TO
GROUND. IS PROBLEM FIXED?

NO I YES

DO STATUS LEDS CONTINUE SLOWLY
BLINKING 60 SECONDS AFTER POWER
UP?

YES I NO

| ]
REPLACE WEGO DONE

MEASURE VOLTAGE LEVEL ON RED
WIRE WITH DVM. IS IT GREATER THAN

IS CALIBRATION SUCCESSFUL?

PERFORM FREE AIR CALIBRATION.

YES

No |
[

REPLACE SENSOR(S).
IS PROBLEM FIXED?

11 VOLTS?
yes | NO | I‘NDJ_XES_I
REPLACE SENSOR(S). WEGO REQUIRES MINIMUM 11 REPLAGE WEGO DONE
IS PROBLEM FIXED? VOLTS, FIX UNDERLYING PROBLEM
T WITH VEHICLE ELECTRIC SYSTEM.
NO YES
| | |
REPLACE WEGO DONE IS PROBLEM FIXED?
| NO | YES |
CALL TECH SUPPORT DONE
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